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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems StepOne™ and
Documentation  StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

Guide Purpose and Audience PN
Applied Biosystems StepOne™ and Explains how to perform experiments on the StepOne and 4376786
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems. Each Getting Started Guide functions as
Getting Started Guide for Genotyping both:
Experiments e A tutorial, using example experiment data provided with the
Applied Biosystems StepOne™ and ASppllgj BTlMosy?tems StepOne ™ Real-Time PCR Software 4376787
StepOnePlus™ Real-Time PCR Systems (StepOne ™ software).
Getting Started Guide for e A guide for your own experiments.

Presence/Absence Experiments Intended for laboratory staff and principal investigators who

perform experiments using the StepOne or StepOnePlus

system 4376785

Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems
Getting Started Guide for Relative
Standard Curve and Comparative Cy

Experiments

Applied Biosystems StepOne™ and 4376784
StepOnePlus™ Real-Time PCR Systems
Getting Started Guide for Standard Curve
Experiments

Applied Biosystems StepOne™ and Explains how to install and maintain the StepOne and 4376782
StepOnePlus™ Real-Time PCR Systems StepOnePlus systems.
Installation, Networking, and Maintenance

Guide Intended for laboratory staff responsible for the installation and

maintenance of the StepOne or StepOnePlus system

Applied Biosystems StepOne™ and 4376783
StepOnePlus™ Real-Time PCR Systems
Installation Quick Reference Card

Applied Biosystems StepOne™ and Provides information about the reagents you can use on the 4379704
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems, including:
Reagent Guide

¢ An introduction to TagMan® and SYBR® Green reagents

e Descriptions and design guidelines for the following
experiment types:

— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who

perform experiments using the StepOne or StepOnePlus
system.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for vii
Presence/Absence Experiments
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How to Use This Guide

Guide

Purpose and Audience PN

Applied Biosystems StepOne™ and Explains how to prepare your site to receive and install the 4376768
StepOnePlus™ Real-Time PCR Systems StepOne and StepOnePlus systems.
Site Preparation Guide

Intended for personnel who schedule, manage, and perform the
tasks required to prepare your site for installation of the StepOne
or StepOnePlus system.

Applied Biosystems StepOne™ Real-Time | Explains how to use the StepOne software to: NA
PCR Software Help

e Set up, run, and analyze experiments using the StepOne and
StepOnePlus systems.

e Monitor networked StepOne and StepOnePlus instruments.
e (Calibrate StepOne and StepOnePlus instruments.

e \Verify the performance of StepOne and StepOnePlus
instruments with an RNase P run.

Intended for:

e Laboratory staff and principal investigators who perform
experiments using the StepOne or StepOnePlus system.

e Laboratory staff responsible for the installation and
maintenance of the StepOne or StepOnePlus system.

Assumptions This guide assumes that you:

Are familiar with the Microsoft Windows® XP operating system.

Are familiar with the Internet and Internet browsers.

Know how to handle DNA and/or RNA samples and prepare them for PCR.
Understand data storage, file transfer, and copying and pasting.

Have networking experience, if you plan to integrate the StepOne or StepOnePlus
system into your existing laboratory data flow.

Text Conventions  This guide uses the following conventions:

viii

User Attention
Words

Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

Italic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open.

Two user attention words appear in Applied Biosystems user documentation. Each word
implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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How to Obtain More Information

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words Alert Words” on page xiii.

How to Obtain More Information

Related Other StepOne and StepOnePlus System Documents

Documentation The documents listed in the table below are not shipped with the StepOne or

StepOnePlus instrument.

Document PN

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376791
Installation Performance Verification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376790
Installation Qualification-Operation Qualification Protocol

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems 4376788
Planned Maintenance Protocol

Documents Related to Genotyping Experiments

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636

Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214

TagMan® Drug Metabolism Genotyping Assays Protocol 4362038

TagMan® SNP Genotyping Assays Protocol 4332856
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for iX
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Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol
PrepMan® Ultra Sample Preparation Reagent Protocol 4318925

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents Related to Standard Curve Experiments

Document PN
Ampilification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TaqgMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
X Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Documents Related to the Reagent Guide

Document PN

Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08
for Experimental Studies Application Note

Note: For more documentation, see “How to Obtain Support” on page xii.

Obtaining The StepOne Software Help describes how to use each feature of the user interface.
Information from  Access the Help from within the software by doing one of the following:
the Software Help . pess FI.
* Click @ in the toolbar.
+ Select Help » StepOne Software Help.

To find topics of interest in the Help:
* Review the table of contents.
» Search for a specific topic.
» Search an alphabetized index.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xi
Presence/Absence Experiments
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How to Obtain Support

Send Us Your Applied Biosystems welcomes your comments and suggestions for improving its user
Comments documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xii).

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.
At the Support page, you can:

* Search through frequently asked questions (FAQs)

* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

* Download PDF documents
* Obtain information about customer training
* Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule
maintenance for your StepOne™ or StepOnePlus’" instrument (such as annual planned
maintenance or temperature verification/calibration), contact the Applied Biosystems
Care Center. To obtain a phone number for or to send an email to the center, go to
http://www.appliedbiosystems.com/support/contact.

Xii Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Presence/Absence Experiments
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Safety Conventions Used in This Document

Safety Conventions Used in This Document

Safety Alert  Four safety alert words appear in Applied Biosystems user documentation at points in
Words the document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level
of observation or action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

A (o:.\UI{e]N] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

AWARNING — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A PL\[e]F38 — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xv).

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for xiii
Presence/Absence Experiments
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Symbols on Instruments

Examples

IMPORTANT! You must create a separate sample entry spreadsheet for each 96-well

plate.

_ (.\1)i[e]]] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

the heated cover and sample block can reach temperatures in excess of 100 °C.

A L[]S ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation. Never operate the system with the grounding conductor disconnected.

Symbols on Instruments

Xiv

Electrical

Symbols Applied Biosystems instruments.

Symbol

Description

Symbol

The following table describes the electrical symbols that may be displayed on

Description

Indicates the On position of the
main power switch.

Indicates the Off position of the
main power switch.

CO-—

S

Indicates a standby switch by
which the instrument is switched
on to the Standby condition.
Hazardous voltage may be
present if this switch is on
standby.

Indicates the On/Off position of a
push-push main power switch.

L

S

Indicates a terminal that may be
connected to the signal ground
reference of another instrument.
This is not a protected ground
terminal.

Indicates a protective grounding

terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.

Indicates a terminal that can
receive or supply alternating
current or voltage.

Indicates a terminal that can
receive or supply alternating or
direct current or voltage.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Symbols on Instruments

The following table describes the safety symbols that may be displayed on

Applied Biosystems instruments. Each symbol may appear by itself or with text that
explains the relevant hazard (see “Safety Labels on Instruments” on page xvi). These
safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that
occur in the text of this and other product-support documents.

Symbol

Description

Symbol

Description

/N
AN

Indicates that you should consult
the manual for further information
and to proceed with appropriate

caution.

Indicates the presence of a hot
surface or other high-temperature
hazard and to proceed with
appropriate caution.

> B B

Indicates the presence of moving
parts and to proceed with
appropriate caution.

Indicates the presence of an
electrical shock hazard and to
proceed with appropriate caution.

Indicates the presence of a laser
inside the instrument and to
proceed with appropriate caution.

Environmental

The following symbol applies to all Applied Biosystems electrical and electronic

Symbols products placed on the European market after August 13, 2005.

Symbol

=,
X
()
]

Description

Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
environmental impact of waste electrical and electronic equipment (WEEE).

European Union customers:

Call your local Applied Biosystems Customer Service office for equipment pick-up
and recycling. See http://www.appliedbiosystems.com for a list of customer

service offices in the European Union.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for XV
Presence/Absence Experiments
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Safety Labels on Instruments
The following CAUTION, WARNING, and DANGER statements may be displayed on

Applied Biosystems instruments in combination with the safety symbols described in the
preceding section.

English Francais

CAUTION Hazardous chemicals. Read the ATTENTION Produits chimiques dangeureux.
Material Safety Data Sheets (MSDSs) before Lire les fiches techniques de sireté de

handling. matériels avant la manipulation des produits.

CAUTION Hazardous waste. Refer to ATTENTION Déchets dangereux. Lire les

MSDS(s) and local regulations for handling fiches techniques de slreté de matériels et la

and disposal. régulation locale associées a la manipulation
et I'élimination des déchets.

CAUTION Hot surface. ATTENTION Surface brilante.

DANGER High voltage. DANGER Haute tension.

WARNING To reduce the chance of electrical | AVERTISSEMENT Pour éviter les risques
shock, do not remove covers that require tool | d'électrocution, ne pas retirer les capots dont

access. No user-serviceable parts are inside. | I'ouverture nécessite |'utilisation d'ouitils.
Refer servicing to Applied Biosystems L’instrument ne contient aucune piéce
qualified service personnel. réparable par I’ utilisateur. Toute intervention

doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts. ATTENTION Parties mobiles.

DANGER Class 3B (lll) visible and/or invisible | DANGER Rayonnement visible ou invisible
LED radiation present when open and d’un faisceau LED de Classe 3B (lll) en cas
interlocks defeated. Avoid exposure to beam. | d’ouverture et de neutralisation des
dispositifs de sécurité. Evitez toute
exposition au faisceau.

Locations of The StepOne and StepOnePlus instruments contain a warning at the location shown
Warnings below:

/A CAUTION HOT

XVi Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Presence/Absence Experiments
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General Instrument Safety

Moving and
Lifting the
Instrument

Moving and
Lifting Computers
and Monitors

Operating the
Instrument

Cleaning or
Decontaminating
the Instrument

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

A \WZ:GUII[e]d PHYSICAL INJURY HAZARD. Using the instrument in a manner

not specified by Applied Biosystems may result in personal injury or damage to the
instrument.

A (o:\0)1[e)')] PHYSICAL INJURY HAZARD. The instrument is to be moved

and positioned only by the personnel or vendor specified in the applicable site
preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

AWARNING Do not attempt to lift or move the computer or the monitor without

the assistance of others. Depending on the weight of the computer and/or the monitor,
moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

» Keep your spine in a good neutral position while lifting with your legs.

 Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:

* Received instructions in both general safety practices for laboratories and specific
safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xviii.

A (O.\I[e]\] Before using a cleaning or decontamination method other than those

recommended by the manufacturer, verify with the manufacturer that the proposed
method will not damage the equipment.

XVii

Presence/Absence Experiments
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Chemical Safety

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning

Chemical Safety

Xviii

Guidelines

About MSDSs

Obtaining
MSDSs

the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

To minimize the hazards of chemicals:

» Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xviii.)

» Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

+ Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to

replace the appropriate MSDS in your files.

The MSDS for any chemical supplied by Applied Biosystems is available to you free
24 hours a day. To obtain MSDSs:

1. Go to https://docs.appliedbiosystems.com/msdssearch.html

2. In the Search field of the MSDS Search page:

a. Type in the chemical name, part number, or other information that you expect
to appear in the MSDS of interest.

b. Select the language of your choice.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Chemical Waste Safety

c. Click Search.

3. To view, download, or print the document of interest:
a. Right-click the document title.

b. Select:
* Open — To view the document

+ Save Target As — To download a PDF version of the document to a
destination that you choose

* Print Target — To print the document

4. To have a copy of an MSDS sent by fax or e-mail, in the Search Results page:
. Select Fax or Email below the document title.

a
b. Click RETRIEVE DOCUMENTS at the end of the document list.

2]

. Enter the required information.

d. Click View/Deliver Selected Documents Now.

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Chemical Waste Safety

Chemical Waste ACAUTION HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Xix
Presence/Absence Experiments
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Electrical Safety

XX

Waste Disposal

Fuses

Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For more safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For more safety
guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying a waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

If potentially hazardous waste is generated when you operate the instrument, you must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

A pJ:\\[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can

result from operating the StepOne or StepOnePlus instrument without its instrument
panels in place. Do not remove instrument panels. High-voltage contacts are exposed
when instrument panels are removed from the instrument.

AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can

damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with fuses of the type and rating specified for the instrument.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

Presence/Absence Experiments



Preface
LED Safety

Power A p2\e]3i] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A PLWNel3i] ELECTRICAL HAZARD. Use properly configured and approved

line cords for the voltage supply in your facility.

A PLN[e]1338 ELECTRICAL HAZARD. Plug the instrument into a properly

grounded receptacle with adequate current capacity.

Overvoltage The StepOne and StepOnePlus instruments have an installation (overvoltage) category of
Rating 1I, and they are classified as portable equipment.

LED Safety

To ensure safe LED operation:

* The system must be maintained by an Applied Biosystems Technical
Representative.

» All instrument panels must be in place on the instrument while the instrument is
operating. When all panels are installed, there is no detectable radiation present. If
any panel is removed when the LED is operating (during service with safety
interlocks disabled), you may be exposed to LED emissions in excess of the
Class 3B rating.

* Do not remove safety labels or disable safety interlocks.

Biological Hazard Safety

General &WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

Biohazard infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
performed in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
http://bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; http://www.access.gpo.gov/ nara/cfr/waisidx_01/
29¢fr1910a_01.html).
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* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

More information about biohazard guidelines is available at:

http://www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:
» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and The StepOne and StepOnePlus instruments have been tested to and comply with
Canadian Safety standard:

Standards ;; 1010A-1/CAN/CSA C22.2 No. 1010.1-92, “Safety Requirements for Electrical
c UI. Equipment for Measurement, Control, and Laboratory Use, Part 1: General
sLjUs Requirements.”

UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory
Equipment for the Heating of Materials.”

FDA “Radiation Control for Health and Safety Act of 1968 Performance Standard 21
CFR 1040.10 and 1040.11,” as applicable.

Canadian EMC This instrument has been tested to and complies with ICES-001, Issue 3: “Industrial,
Standard Scientific, and Medical Radio Frequency Generators.”

European Safety Safety

Sand dE N(IjC This instrument meets European requirements for safety (Low Voltage Directive
tandards 73/23/EEC). This instrument has been tested to and complies with standards EN 61010-
c € 1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements.”
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EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of
Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic
Laboratory Equipment for Analysis and Other Purposes.”

EN 60825-1, “Radiation Safety of Laser Products, Equipment Classification,
Requirements, and User’s Guide.

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 89/336/EEC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

Australian EMC  This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
Standards and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,

o Scientific, and Medical (ISM) Radio-frequency Equipment.”
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n Get Started

This chapter covers:

B About the StepOne"™ and StepOnePlus™ Systems . . ........................ 2
B Supported Consumables . .. .....coi i 4
B About Presence/Absence Experiments. ... ............... .. ..., 6
B HowtoUse This Guide. .. ... ... ...t 9
B About the Example Experiment . . ............. ... ... .. i, 10
B Example Experiment Workflow .. ........ . ... ... ... ... ... .. ... ... ... 12

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 1
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About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

System Features
Applied Biosystems StepOne™ Real-Time ¢ 48-well platform
PCR System (StepOne ™ system) e Three-color system
Applied Biosystems StepOnePlus™ Real- e 96-well platform
Time PCR System (StepOnePlus™ system) « Four-color system

* VeriFlex™ sample blocks

The StepOne and StepOnePlus systems use fluorescent-based polymerase chain reaction
(PCR) reagents to provide:

» Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs
post-PCR).

About Data The StepOne and StepOnePlus systems collect raw fluorescence data at different points
Collection during a PCR, depending on the type of run that the instruments perform:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data following each
extension step of the PCR.
Relative standard
curve

Comparative Ct

(AACy)
Post-PCR Genotyping The instrument collects data:
(endpoint) runs Presence/absence Before the PCR (For presence/absence

experiments, data collection before the PCR is
optional, but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time); collecting
data during the run can be helpful for
troubleshooting.

e After the PCR

Regardless of the run type, a data collection point or read on the StepOne™ or
StepOnePlus™ instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

Notes
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2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The StepOne'™ software stores the
raw fluorescent image for analysis.

After a run, the StepOne software uses calibration data (spatial, dye, and background) to
determine the location and intensity of the fluorescent signals in each read, the dye
associated with each fluorescent signal, and the significance of the signal.

About the Filters The StepOne and StepOnePlus systems use the following filters:

StepOne system StepOnePlus system
Filter Dye Filter Dye
1 | FAM™ dye 1 | FAM™ dye
SYBR® Green dye SYBR® Green dye
2 | JOE™ dye 2 | JOE™ dye
VIC® dye VIC® dye
3 ROX™ dye 3 TAMRA™ dye
NED™ dye

4 | ROX™dye

About the The StepOnePlus instrument contains six independently thermally regulated VeriFlex™
VeriFlex™  blocks to help you optimize your thermal cycling conditions. You can set a different
Technology temperature for one or more of the VeriFlex blocks, creating up to six different zones for
samples, or you can set the same temperature for each of the VeriFlex blocks.

For More For information on:

Information + The StepOne and StepOnePlus systems, refer to Applied Biosystems StepOne"
Real-Time PCR Software Help.

Note: To access the Help, select Help » StepOne Software Help from within the
StepOne software.

+ Genotyping experiments, refer to Applied Biosystems StepOne"" and StepOnePlus"™
Real-Time PCR Systems Getting Started Guide for Genotyping Experiments.

+ Relative standard curve and/or comparative C (AAC;) experiments, refer to
Applied Biosystems StepOne"" and StepOnePlus™" Real-Time PCR Systems Getting
Started Guide for Relative Standard Curve and Comparative Cp Experiments.

+ Standard curve experiments, refer to Applied Biosystems StepOne"" and
StepOnePlus™™ Real-Time PCR Systems Getting Started Guide for Standard Curve
Experiments.

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 3
Presence/Absence Experiments



n Chapter 1 Get Started

Supported Consumables

Supported Consumables

StepOne System  The StepOne system supports the consumables listed below. These consumables are for
use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number
¢ MicroAmp™ Fast Optical 48-Well Reaction Plate e 4375816
¢ MicroAmp™ 48-Well Optical Adhesive Film e 4375323 and
4375928
e MicroAmp™ Fast 8-Tube Strip e 4358293
e MicroAmp™ Optical 8-Cap Strip e 4323032
* MicroAmp® Fast Reaction Tube with Cap e 4358297
¢ MicroAmp™ Fast 48-Well Tray e 4375282
¢ MicroAmp™ 48-Well Base Adaptor e 4375284
¢ MicroAmp™ 96-Well Support Base e 4379590

Consumable

MicroAmp™ Fast Optical 48-Well Reaction Plate
MicroAmp™ Fast 48-Well Tray

MicroAmp™ 96-Well Support Base

MicroAmp™ Optical 8-Cap Strip

MicroAmp™ Fast 8-Tube Strip

MicroAmp® Fast Reaction Tube with Cap
MicroAmp™ 48-Well Optical Adhesive Film
MicroAmp™ 48-Well Base Adaptor

I & mMm m O O W » =

Notes
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StepOnePlus The StepOnePlus system supports the consumables listed below. These consumables are
System for use with both standard and Fast reagents/protocols.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the StepOne and StepOnePlus systems, even when performing an experiment with
standard reagents.

Consumable Part Number

¢ MicroAmp™ Fast Optical 96-Well Reaction Plate with e 4346906 and
Barcode 4366932

¢ MicroAmp™ Optical Adhesive Film e 4360954 and
4311971
¢ MicroAmp™ Fast 8-Tube Strip e 4358293
e MicroAmp™ Optical 8-Cap Strip e 4323032
¢ MicroAmp® Fast Reaction Tube with Cap e 4358297
e MicroAmp™ 96-Well Tray for VeriFlex™ Blocks e 4379983
e MicroAmp™ 96-Well Support Base e 4379590
¢ MicroAmp™ Adhesive Film Applicator e 4333183
¢ MicroAmp™ Cap Installing Tool (Handle) e 4330015

Consumable

MicroAmp™ Fast Optical 96-Well Reaction Plate
MicroAmp™ 96-Well Tray for VeriFlex™ Blocks
MicroAmp™ 96-Well Support Base

MicroAmp™ Optical 8-Cap Strip
MicroAmp™ Fast 8-Tube Strip

MicroAmp® Fast Reaction Tube with Cap

O/ M m o O W > *

MicroAmp™ Optical Adhesive Film

Notes
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About Presence/Absence Experiments

Endpoint
Experiments

About Presence/
Absence
Experiments

Supported
Reagents

Notes

Presence/absence experiments are endpoint experiments. In endpoint experiments:

* Data are collected at the end of the PCR process.

* Reactions are characterized by the quantity of target accumulated at the end of PCR
(Saiki et al., 1985).

* The datapoint is the normalized intensity of the reporter dye, or Rn.

Note: Some endpoint experiments also include pre-PCR datapoints. If so, the system
calculates the delta Rn (ARn) value per the following formula:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter

Note: In this guide, the term experiment refers to the entire process of performing a run
using the StepOne or StepOnePlus system, including setup, run and analysis.

Perform a presence/absence experiment to detect a specific target in a sample.

The StepOne and StepOnePlus systems support the following reagents for
presence/absence experiments:

+ TagMan® reagents (page 7)
* Other fluorescent-based reagents (page 7)

Note: Presence/absence experiments are not supported for Fast master mix or Fast
protocols.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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TagMan Reagents

TagMan reagents use a fluorogenic probe to enable detection of a target sequence
(unknown target) and IPC sequence (IPC target). During amplification, the unknown
target and the IPC target generate reporter fluorescence signals such that positive or
negative calls can be made on samples (Saiki ef al., 1985).

TagMan® Reagents or Kits Process
Advantages PCR and Detection of cDNA
* Increased specificity with the addition of a & Rosay Components o
H Probe / Reverse primer
fluorogenic probe. T G @ "
¢ Provides multiplex capability. R R
L . CDNA Template ‘(2
¢ Preformulated assays, optimized to run e \j% — o
under universal thermal cycling conditions, s s
are available. ~g=
. . . b. Denatured Template and Annealing of Assay Components _
leltatlons ’ e T T /5 Roverse primer LEGEND
Requires synthesis of a unique fluorogenic . e o © e
probe. - N o e B) quencher
. - ; - g/l‘r;;rGroove
c. Signal Generation AmpliTag Gold®
) . DNA Polymerase
T T L, Probe
:;i h Reverse primer Primer
R Forward primer f‘& _ jmes B
I AR e T AN IR AReReeE femplte
3 5 Extended Primer

About the PCR
Reactions

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for

Other Reagents
If you use other fluorescent-based reagents on the StepOne and StepOnePlus systems,
note the following:

* You must design your experiment using Advanced Setup instead of the Design
Wizard. (See “Advanced Setup Workflow” on page 110.)

* For Applied Biosystems TagMan reagents, the StepOne software automatically
calculates reaction volumes in the Reaction Setup screen.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as a
reporter or quencher with the StepOne system. TAMRA dye may be used as a reporter or
quencher with the StepOnePlus system.

With presence/absence experiments, you prepare PCR reactions that contain primers and
probes to amplify the target and a reagent to detect amplification of the target. You can
set up the PCR reactions for the presence/absence experiments three different ways:

Presence/Absence Experiments
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IPC setup — Use an internal positive control (IPC) to monitor the PCR progress and
ensure that a negative result is not caused by failed PCR in the sample. PCR reactions
contain two primer/probe sets: One to detect the unknown target (unknown target primer
set and TagMan probe to detect the unknown target) and one to detect the IPC (IPC
primer set and a VIC dye-labeled TagMan probe to detect the [PC template). With this
setup, there are three well types:

* Unknown-IPC wells — Wells contain sample template and IPC template; the
presence of the target is not known.

* Negative control-IPC wells — Wells contain IPC template and water or buffer
instead of sample template in the PCR reaction. Only the IPC template should
amplify in negative control-IPC wells because the reaction contains no sample
template. Also called /PC+.

* Negative control-blocked IPC wells — Wells contain IPC blocking agent instead of
sample template in the PCR reaction. No amplification should occur in negative
control-blocked IPC wells because the reaction contains no sample template and
amplification of the IPC is blocked. Also called no amplification control (NAC).

No IPC, singleplex setup — Use Advanced Setup to omit the IPC from your
presence/absence experiment. PCR reactions contain one primer/probe set. PCR
reactions do not contain the IPC. With this setup, there are two well types:

* Unknown wells — Wells contain sample template; the presence of the target is not
known.

* Negative controls —Wells contain water or buffer instead of sample template.

No IPC, multiplex setup — Use Advanced Setup to omit the IPC from your
presence/absence experiment and detect two targets in one reaction. PCR reactions
contain two primer/probe sets. PCR reactions do not include the IPC. With this setup,
there are two well types:

* Unknown-Unknown wells — Wells contain sample template; the presence of the
target is not known.

* Negative control-Negative control wells — Wells contain water or buffer instead of
sample template.

About the With presence/absence experiments, the instrument runs can include:

Instrument Run * Pre-PCR read — Perform the pre-PCR read on the StepOne or StepOnePlus
instrument before PCR amplification to collect baseline fluorescence data.

* Amplification — Perform amplification on the StepOne or StepOnePlus instrument
to collect fluorescence data during PCR amplification. If you do not include
amplification in the run method, you need to perform amplification on another
instrument.

* Post-PCR read — The post-PCR read is required to determine the results for
presence/absence experiments. Perform the post-PCR read on the instrument after
PCR amplification to collect endpoint fluorescence data.

Fluorescence data collected during the instrument run are stored in an experiment data
file (.eds).

Notes
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About the Data from the instrument run are used to determine presence/absence calls. Results are
Analysis plotted in a presence/absence plot. If the experiment includes amplification, results are
plotted in an amplification plot.

Pre-PCR read — If included, the data collected from the pre-PCR read can be used to
normalize data collected from the post-PCR read.

Amplification — If included, the data collected from the amplification can be used to
troubleshoot.

Post-PCR read — The data collected from the post-PCR read are used to make
presence/absence calls:

* Presence — The target amplified above the target’s threshold. The target is present in
the sample.

» Absence — The target did not amplify above the target’s threshold. The target is
absent in the sample.

¢ Unconfirmed

With the IPC setup, the data collected form the post-PCR read are used to make the
following calls:
* IPC Failed — The IPC target did not amplify in the [PC wells and/or the IPC target
amplified in the blocked IPC wells.

¢ IPC Succeeded — The IPC target amplified in the IPC wells and the IPC target did
not amplify in the blocked IPC wells.

How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide Using example experiment data provided with the StepOne software, you can use this
as a Tutorial guide as a tutorial for performing a presence/absence experiment on a StepOne or
StepOnePlus system. Follow the procedures in chapters 2 to 5:

Chapter Procedure
2 Design the experiment using the Design Wizard in the StepOne software.
3 Prepare the experiment, using the reagents and volumes calculated by the

Design Wizard in Chapter 2.

4 Run the experiment on a StepOne or StepOnePlus instrument (standalone or
colocated layout).

5 Analyze the results.

For more information, see “About the Example Experiment” on page 10.

Notes
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Using This Guide
With Your Own

Experiments

After completing the tutorial exercises in Chapter 2 to 5, use this guide to lead you
through your own presence/absence experiments. Each procedure in Chapters 2 to 5
includes a set of guidelines that you can use to perform your own experiments.

Additionally, you can use one of the other workflows provided in the StepOne software to
perform your experiments. The table below provides a summary of all the workflows
available in the StepOne software.

Workflow Description See...

Design Wizard | Set up a new experiment with guidance from the software. | Chapter 2
The Design Wizard walks you through best practices as
you create your own experiment. The Design Wizard is
recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 110

Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no plate setup information. If page 111
desired, you can add all design parameters after the run.

Template Set up a new experiment using setup information from a page 113
template.

Export/Import Import experiment designs from ASCII text files that page 115

contain experiment setup information.

About the Example Experiment

Description of the

Notes

10

Presence/
Absence
Experiment

To illustrate how to perform presence/absence experiments, this guide leads you through
the process of designing, preparing, running and analyzing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a StepOne or StepOnePlus system.

The objective of the presence/absence example experiment is to determine if a pathogen
is present or absent in each batch of ground beef.

In the presence/absence example experiment:

+ DNA is extracted from samples using the PrepMan® Ultra Sample Preparation
Reagent. The DNA is extracted from bacteria found in five samples of ground beef.

* The target is a pathogen.

* The experiment is designed for duplex PCR, where each reaction contains two
primer/probe sets. One set detects the unknown target (primer set and FAM™ dye-
labeled probe to amplify and detect the target sequence.) The other primer/probe set
detects the IPC primer set and VIC® dye-labeled TagMan probe amplifies and
detects the IPC template.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Reaction Plate The presence/absence example experiment was created for a StepOne instrument. For the
Layout StepOne instrument, the software displays a 48-well reaction plate layout:
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You can create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the 48-well reaction plate layout shown throughout
this guide. For the StepOnePlus instrument, the software displays a 96-well reaction plate
layout:
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About the In this getting started guide you will use two files:
Example

. * In Chapter 2, you will create a presence/absence example experiment file that
Experiment Data

contains setup data and save it to the experiments folder on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\
Presence Absence Example.eds

Notes
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Example Experiment Workflow

* In Chapter 5, you will view results in a presence/absence example experiment file
that contains run data. The data file for the example experiment installs with the
StepOne software. You can find the data file for the example experiment on your
computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Presence Absence Example.eds
where:

* <drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

* <software name> is the current version of the StepOne software.

Data Files in the Examples Folder

The examples folder contains several data files that you can reference when analyzing
your own data, as listed below. The data files install with the StepOne software.

Note: Be sure to use the Presence Absence Example.eds file when performing the
tutorial procedures in this guide. The 96-Well Presence Absence Example.eds file is a
different example of a presence/absence experiment.

StepOne Instrument StepOnePlus Instrument
Comparative CT Example.eds | 96-Well Comparative CT Example.eds
Multiplex Example.eds | 96-Well Multiplex Example.eds
Genotyping Example.eds 96-Well Genotyping Example.eds
Presence Absence Example.eds 96-Well Presence Absence Example.eds
Relative Standard Curve Example.eds 96-Well Relative Standard Curve

Example.eds

RNase P Experiment.eds 96-Well RNase P Experiment.eds
Standard Curve Example.eds 96-Well Standard Curve Example.eds
SYBR Example.eds 96-Well SYBR Example.eds

Example Experiment Workflow

The figure on page 13 shows the workflow for the presence/absence example experiment.

Notes

12 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Design the Experiment (Chapter 2)
. Create a new experiment.
. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.
. Set up the samples.
. Set up the run method.
. Set up the reactions.
. Order materials for the experiment.

© 00 N O O A~ WO N =

. Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)
. Prepare the template.
. Prepare the samples.
. Prepare the reaction mix.

AW N =

. Prepare the reactions.

v
Run the Experiment (Chapter 4)
. Prepare for the run.
. (Optional) Enable the notification settings.
. Start the run.
. Monitor the run.

a WO N =2

. Unload the instrument and transfer the data.
v
Analyze the Experiment (Chapter 5)
Section 1, Review Results:
. Analyze the experiment.
. View the presence/absence plot.
. View the amplification plot.
. View the results in a table.
. Publish the data
Section 2, Troubleshoot (If Needed):
1. View the analysis settings.

a A~ WO N =

. View the quality summary.
. Omit wells.
. View the multicomponent plot.

a A~ W N

. View the raw data plot.

Notes
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Example Experiment Workflow

Notes
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Chapter 2

Design the Experiment

This chapter covers:

B Chapter OVeIrVIEW . . . oottt e e e e e e 16
B Createa New Experiment. . .. ....... ...t 17
B Define the Experiment Properties .......... ... .. .. ... .. .. .. .. ... ... 20
B Define the Methods and Materials . . .. .......... .. .. ... .. i, 23
B SetUpthe Targets. . . ..ottt e e e e 25
B Set Up the Samples and Replicates. . ........... ... ... ... .. i, 26
B SetUpthe RunMethod ......... ... .. ... . . .. . . . . . 29
B Review the Reaction Setup. ... i 31
B Order Materials for the Experiment .. ............. .. ... ... ... 35
B Finish the Design Wizard .. ...... .. ... .. . i i 38

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne'" Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to use the Design Wizard in the StepOne"™ software to set up
the presence/absence example experiment. The Design Wizard walks you through
Applied Biosystems recommended best practices as you enter design parameters for the
example experiment.

Example The workflow for designing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow
Note: Design the example experiment using the Design Wizard in the StepOne software.
When you design your own experiments, you can select alternate workflow (see “Using
This Guide With Your Own Experiments” on page 10).

Start Experiment

h 4
Design the Experiment (Chapter 2)

. Create a new experiment.

. Define the experiment properties.

. Define the methods and materials.
. Set up the targets.

Set up the samples.

Set up the run method.

. Review the reaction setup.

. Order materials for the experiment.

© ® N O oA WD

. Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v

End Experiment

Notes
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Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the StepOne software.

Create an 1. Double-click € (StepOne software shortcut) or select
Experiment Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
2. From the Home screen, select Design Wizard to open the Design Wizard.

IFHP. Edit Instrument Analysis Tools Help I

[l New Experiment - 5 open.. [ N 3 send Experiment to Instrument... B¢, Download Experiment from Instrument .| 4 B

Analyze

Design Wizard QuickStart Analyze Experiment

2
3. See “Software Elements” below for information on navigating within the Design
Wizard.
Notes
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 17
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Create a New Experiment

Software The StepOne software elements for the Design Wizard are illustrated below.

Elements _ ) _
1. Menu bar — Displays the menus available in the software:

* File

* Edit

* Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
» Save
* Close
* Send Experiment to Instrument
» Download Experiment from Instrument
* Export
» Print Report

3. Experiment header - Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Navigation pane — Provides links to all screens in the Design Wizard:
* Experiment Properties
* Methods & Materials
» Targets
» Samples & Replicates
¢ Run Method
* Reaction Setup
* Materials List
Note: The Design Wizard initially displays the Quantitation - Standard Curve
experiment type. The available Design Wizard screens may change when you select

a different experiment type. For example, the Samples & Replicates screen is not
displayed until you select the presence/absence experiment type.

5. Experiment tab(s) — Displays a tab for each open experiment.

Notes
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Create a New Experiment

:Fl\e Edit Instrument Analysis Tools Help

N —

I|:| New Experiment = [ open . [ 5 Closs {.J_'I Send Experiment to Instrument... ¢, Download Experiment from Instrument. .| 48 B P

Reagents: TagMan® Re

3 Experiment: Untitl Type: Quantitation - Standard Curve

1A. Define: Experiment Properties Experiment Properties Help @)

1. Define
a Instructions: Enter an experiment name, selectthe instrumenttype, then selectthe type of experiment to design.

How do you want to identify this experiment? = Required

* Experiment Name:

* Experiment
Properties

Barcode (Optional): ‘

User Name (Optional): ‘ |
2. SetUp Comments (Optional) ‘ f‘_'.|
v

Which instrument are you using to run the experiment?

[ StepCnePlus™ Instrument (96 Wells) ] { + StepCne™ Instrument (48 Wells) ]

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

[ « Quantitation ] [ Genotyping ] [ Presence / Absence ]

Desian a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample.

3. Order ( Optional)

+ Finish Designing Experiment

5 1 v e ] Untitled <

Notes
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Define the Experiment Properties

On the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the presence/absence example experiment:
Exe_tmple » The experiment is identified as an example.
Experiment : : . .
* The instrument selected to run the experiment is the StepOne instrument.
+ A MicroAmp™ Fast Optical 48-Well Reaction Plate is used.

» The experiment type is presence/absence.

Complete the 1. Click the Experiment Name field, then enter Presence Absence Example.

Experiment
Properties Screen Note: The experiment header updates with the experiment name you entered.

2. Leave the Barcode field empty.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Presence Absence Getting Started Guide
Example.

5. Select StepOne™™ Instrument (48 Wells).

Note: The example experiment was created for a StepOne instrument. You can
create the example experiment for a StepOnePlus instrument; however, your
reaction plate layout will differ from the layout shown in this guide. The software
displays a 48-well reaction plate layout for the StepOne instrument and a 96-well
reaction plate layout for the StepOnePlus instrument. To create the example
experiment for a StepOnePlus instrument, select StepOnePlus™ Instrument
(96 Wells).

6. Select Presence/Absence for the experiment type.

7. Click Next =.

Notes
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Define the Experiment Properties

1A. Define: Experiment Properties Experiment Properties Helpp @

a Instructions: Enter an experiment name, selectthe instrument type, then select the type of experiment to desian

How do you want to identify this experiment? = Required

*ExpefimentMame: | Presence Absence Example

Barcode (Optional): |

AW N

|
|
User Name (Optional): | Example User |

H Lol Tp L R (TN IDLEVMF resence Absence Getting Started Guide Example

5 Which instrument are you using to run the experiment?

{ StepCnePlus™ Instrument (95 Wells) ] ‘ ¥ StepOne™ Instrument (48 Wells) ]

Setup, run, and analyze an experiment using a 3-color, 48-well system

What type of experiment do you want to design?

{ Quantitation ] { Genotyping ] ‘ + Presence [ Absence ]

Design a presence/absence experiment to determine whether a target nucleic acid sequence is present or alisentin a sample.

Design  When you design your own presence/absence experiment:

Guidelines * Enter an experiment name:

— Enter a name that is descriptive and easy to remember. You can enter up to 100
characters in the Experiment Name field.

Note: You cannot use the following characters in the Experiment Name field:
forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (|), colon (:), or
semicolon (;).

— The experiment name is used as the default file name.

* (Optional) If you are using a MicroAmp"" Fast Optical 96-Well Reaction Plate, enter
a barcode to identify the barcode on the reaction plate. You can enter up to 100
characters in the Barcode field.

Note: The MicroAmp Fast Optical 48-Well Reaction Plate does not have a barcode.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name (Optional) field.

* (Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.

Notes
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Notes

22

Select the instrument you are using to run the experiment;:
— StepOne™ Instrument (48 Wells)
— StepOnePlus’” Instrument (96 Wells)

Note: You can use StepOne Software v2.0 or later to design experiments for both
the StepOne and StepOnePlus instruments. The instrument you select in the
Experiment Properties screen affects the reaction plate layout and materials list.

Note: To set the default instrument type, select Tools » Preferences, then select the
General tab (default). From the Default Instrument Type dropdown menu, select the
appropriate instrument.

Select Presence/Absence as the experiment type.

For More For more information on:

Information

L]

Completing the Experiment Properties screen, access the StepOne Software Help by
clicking @ or pressing F1.

Consumables, see “Order Materials for the Experiment” on page 35.

Presence/absence experiments, refer to the Applied Biosystems StepOne"™ and
StepOnePlus™ Real-Time PCR Systems Reagent Guide.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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Define the Methods and Materials

On the Methods & Materials screen, view the reagents, DNA template and ramp speed to
use for the experiment.

About the In the presence/absence example experiment:
Example .

A TaqMan reagents are used.
Experiment

* The standard ramp speed is used in the instrument run.
* DNA template is the type of nucleic acid sample added to the PCR reactions.

—

Complete the
Methods &
Materials Screen

Make sure TaqMan® Reagents is displayed for the reagents.

2. Make sure DNA is displayed for the template type.

3. Make sure Standard (~2 hours to complete a run) is displayed for the ramp speed.
4. Make sure Pre-PCR Read and Amplification are selected for the stages.
5

. Click Next =.

1B. Define: Methods & Materials Methods & Materials Help @

a Instructions: Review the reagents and type of tamplate to use for this presencefahsence experiment, then select the stages for the instrument run

Use TagMan® reagents in the PCR reactions for this presence/absence experiment.

1 i + TagMan® Reagents ]

The PCR reactions contain a forward primer, a reverse primer, and a Taghan probe. The primers are designed to amplify the target sequence. The TagMan probe is designed to
hybridize to the target sequence and generate luorescence signal when the target sequence is amplified

Use a DNA template in the PCR reactions for this presence/absence experiment.
2 ' ]

T ¥ DNA

Use an optimized protocol to extract the DNA. Then, make sure the A260/280 ratio is greaterthan 1.7, agarose gel electrophoresis shows the DNA is intact, and the DNA has not been
heated above 60 °C.

Use the standard ramp speed for this presence/absence experiment.

3 :J Standard (~ 2 hours to complete a run,‘l]

For optimal results using the standard ramp speed, Applied Biosystems recommends standard reagents for your PCR reactions

Which stages do you want to include in the instrument run?

4 [¥] Pre-PCR Read I‘E| Amplification

Notes
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Design  When you design your own presence/absence experiment:

Guidelines .

TagMan Reagents use a TagMan probe to detect amplification of the target. In the
presence/absence experiments, TagMan reagents consist of two primer/probe sets.
The primers are designed to amplify the target and the IPC template. The TagMan
probes are designed to hybridize to the target and the IPC and generate fluorescence
signal when the target and IPC are amplified.

Note: Applied Biosystems recommends that you use TagMan reagents for
presence/absence experiments. If you want to use other reagents, use Advanced
Setup to set up your experiment.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye
as a reporter or quencher with the StepOne"™ system. TAMRA dye may be used as a
reporter or quencher with the StepOnePlus’ system.

DNA template is used in the presence/absence experiment.
Select the Standard ramp speed for the instrument run.

IMPORTANT! The Design Wizard does not support Fast ramp speeds for
presence/absence experiments. If you want to use Fast ramp speeds, use Advanced
Setup to set up your experiment.

Select the appropriate stages for the instrument run:

— Pre-PCR Read- If you do not want to collect data before amplification, deselect
the Pre-PCR Read checkbox.

Note: Applied Biosystems recommends that you include the pre-PCR read in
the StepOne or StepOnePlus instrument run.

— Amplification — If you want to perform amplification on a thermal cycler,
deselect the Amplification checkbox.

Note: Applied Biosystems recommends that you include the amplification
stage in the StepOne or StepOnePlus instrument run. You can use the data
collected during amplification to troubleshoot.

— Post-PCR Read — This required stage is preselected for you.

For More For more information on:

Information .

Notes

Completing the Methods & Materials screen, access the StepOne Software Help by
clicking @ or pressing F1.

TagMan reagents, refer to the Applied Biosystems StepOne™" and StepOnePlus™
Real-Time PCR Systems Reagent Guide.

Using Advanced Setup, see “Advanced Setup Workflow” on page 110.

PCR, including singleplex vs. multiplex PCR refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide.
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Set Up the Targets

Set Up the Targets

On the Targets screen, enter the name of the target you want to detect in the PCR reaction
plate (Unknown), then enter the name of the internal positive control (IPC) target.

About the In the presence/absence example experiment:
Example .

A A pathogen is used as the unknown target and an IPC is used as the IPC target. The
Experiment

IPC target ensures that a negative result is not the result of a failed PCR reaction.
» Each well in the reaction plate contains an IPC.

Complete the 1. Click the What is the name of the target you want to detect (Unknown)? field,
Targets Screen then enter Pathogen.

2. Click the What is the name of the IPC target? field, then enter IPC.

Note: The Targets Used in Experiment table updates with the target names.

3. Leave the default colors in the Color dropdown menus.

4. Click Next =.

2A Set Up: Targets Targets Help 9_)
B instructions: Enter the name of the target to detect in the reaction plate (Unknown), then enter the name of the internal positive control (IPC) target.
Set Up: Targets
*What is the name of the target you want to detect (Unknown)? The unknown target is detected using FAM Pathogen 1
*What is the name of the |PC target? The IPC target is detected using VIC reporter dye IPC Enter IPC target name
\ 2
Targets Used in Experiment
Task Target Name Repaorter Quencher Color
URKMOWR Pathogen FAM NFQ-MGB v ” || 3
IPC IPC VIC NFQ-MGB v
Notes
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Design  When you design your own presence/absence experiment:

Guidelines  Identify the target and the IPC with a unique name and color. You can enter up to
100 characters for the unknown target name and the IPC target name.

 In the Design Wizard, the unknown target is detected using a FAM dye-labeled
TagMan probe and the IPC target is detected using a VIC dye-labeled TagMan
probe.

Note: If you want to set up your presence/absence experiments without the IPC,
perform advanced setup. See “Advanced Setup Workflow” on page 110.

For More For more information on completing the Targets screen, access the StepOne Software
information Help by clicking @ or pressing F1.

Set Up the Samples and Replicates

On the Samples & Replicates screen, enter the number of samples, replicates, and
negative controls to include in the reaction plate, enter the sample names, then select
which sample/target reactions to set up.

About the In the presence/absence example experiment:

Exqmple » Five samples are used. In the samples, the presence/absence of the target (a
Experiment pathogen) is unknown.

* Eight Unknown-IPC replicates are used. Replicates are identical to the sample
reactions, containing identical components and volumes.

» Four Negative Control-Blocked IPC replicates are used. Replicates contain IPC
template and IPC blocking agent instead of sample template.

* Four Negative Control-IPC replicates are used. Replicates contain IPC template and
buffer or water instead of sample template.

Complete the 1. Click the How many samples do you want to test in the reaction plate? field, then
Samples & enter 5.

Replicates .
Screen 2. In the Enter Sample Name fields, enter:

¢ Unknown 1
¢ Unknown 2
¢ Unknown 3
¢ Unknown 4
¢ Unknown 5

3. Leave the default colors in the Color dropdown menus.

4. Click the How many replicates do you need for reactions that contain sample?
(Unknown-IPC wells) field, then enter 8.

Notes
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5. Click the How many replicates do you need for reactions that contain IPC
blocking agent instead of sample? (Negative Control-Blocked IPC wells) field,
then enter 4.

6. Click the How many replicates do you need for reactions that contain water or
buffer instead of sample? (Negative Control-IPC wells) field, then enter 4.

7. In the Well Count pane, confirm that there are:
e 40 Unknown-IPC @
4 Negative Control-Blocked IPC [
4 Negative Control-IPC [
* 0 Empty

8. In the View Plate Layout pane:

a. From the Arrange Plate by dropdown menu, select Rows.

b. From the Place Negative Controls in dropdown menu, select Upper Left.

9. Click Next =

3
2B. Set Up: Samples & Replicates Samples & Replicates Help )
Instructions: Enter the number of samples to test in the reaction plate, enter sample names, then enter the number of replicates for each type of reaction.
g
(T .
a
1 * How many samples do you want to testin the reaction plate? ‘ 5 Arrange Plate by |Rows L Place Negative Controls in: Upper Left
For each sample in the reaction plate, enter a sample name and select a sample color. — — 8b
* Enter Sample Mame Caolor | ElsncwinWeHsv | ViewLegend |
[Unknown 1 | ¥ 2 [ s [ 4 [ s [ e [ 7 [ 8 |
2 unknawn 2 | ] R [ path... [Z] patn.. [ Patn.. [X] Patn.. [ Path.. [ Patn.. [X] patn.. [ Path.
[unknown 3 | v Hwc [Hirc [Hwrc [Hrc [lirec e [@irc Wlirc
‘UﬂknDWM | g [ Unknow... Unknow... Unknow... Unknow... Unknow... Unknow... Unknow... Unknow..
g | [ path.. [T patn.. [ path.. [T path.. [ Patn.. [ path.. [T Patn.. [ Path.
‘UﬂknDWﬂ5 | ] e Fllirc Bliec Flliee e Fliec Wl Wlirc
| Unknow. Unknow. Unknow. Unknow. Unknow. Unknow. Unknow. Unknow.
¢ | [ patn... [T patn.. [0 patn.. [T patr.. [ patn.. [T patn.. [T Patr.. [T Patn
e Elire e Elliec Elwec Eliec [l Elirc
: How many replicates do you need for reactions that contain sample? (Unknown-IPC wells) I——‘E—I o ':):’:h-. ':):’:h-. ':):’:h-. ':):’:h-. ':):’:h-. ':,:"“h-. ':,:"“h-. ':,:"“h-.
How many replicates do you need for reactions that contain IPC blocking agent instead of sample? (Megative Ij‘ e Blec Blec Bec @ec Bec Blec Hiec
6 Control-Blocked IPC wells) | |, | e, | e | e | e, | e, | e
How many replicates do you need for reactions that contain water or buffer instead of sample? (Negative E Pa‘” Pa‘” Pa‘” Pa‘” Pa‘” Pa‘” Pa‘” Pa‘”
Contral-IPC wells) e Elire e Elliec Elwec Eliec [l Elirc
|| unkmon...| Unknew..| Unkmow... Unimom...| Unknew.. Urknw...| Uimon...| Unknow.
£ | @ patn.. [ path... [T patn.. [ Patn.. [T pat.. [T Patn.. [ path.. [T path.
7 —1 I 40 - Unknown-IPC 4 - Negative Control-Blocked IPC 4 - Negative Control-IPC 0- Emply IPC IPC IPC IPC IPC IPC IPC IPC
Design  When you design your own presence/absence experiment:
Guidelines + Identify each sample with a unique name and color. You can enter up to 100
characters in the Sample Name field.
* Enter the number of Unknown-IPC replicates to set up. Applied Biosystems
recommends 3 Unknown-IPC replicates.
» Enter the number of Negative Control-Blocked IPC replicates to set up. Applied
Biosystems recommends 3 Negative Control-Blocked IPC replicates.
Notes
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* Enter the number of Negative Control-IPC replicates to set up. Applied Biosystems
recommends 3 Negative Control-IPC replicates.

 If the number of reactions required exceeds the number of wells in the reaction
plate, reduce the number of samples, Unknown-IPC replicates, Negative Control-
Blocked IPC replicates, and/or Negative Control-IPC replicates.

* If you are running the experiment on a StepOnePlus instrument and plan to edit the
Run Method (page 29) to set a different temperature for one or more of the VeriFlex
blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen, select the Assign Targets and Samples tab, select
the View Plate Layout tab, then select the Enable VeriFlex"" Block checkbox.

IMPORTANT! If you do not select the Enable VeriFlex™ Block checkbox in the
Plate Setup screen, you will not be able to set a different temperature for one or
more of the VeriFlex blocks in the Run Method screen (page 29).

For More For more information on completing the Samples & Replicates screen, access the
Information  StepOne Software Help by clicking @ or pressing F1.

Notes
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Set Up the Run Method

On the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method, or replace it with one
from the library.

About the In the presence/absence example experiment, the default run method is used without
Example edits.

Experiment
Review the Run 1. Click either the Graphical View tab (default) or Tabular View tab.
Method Screen ) . _
2. Make sure the Reaction Volume Per Well field displays 20 pL.
3. Make sure the Pre-PCR Read and Amplification checkboxes are selected.
4. Make sure the thermal profile displays the holding and cycling stages shown below.
5. Click Next =.
2(C. Set Up: Run Method Run Method Help @)
1 n Instructions: Review the reaction volume and the default thermal profile for the stages you selected for the instrument run. If needed, change your selection, edit the run method, or replace the run method with one from
j Graph‘ical View T Tabular View 1
2 Reaction Valume Per Well ‘200 HL
| Add Stage ¥ | Add Step ¥ ‘ || CollectData ¥ M Open Run Method | Save Run Method ‘
3
4 ‘ Include: PrerPCR Read [] Amplification
Pre-PCR Read (Holding Stage) Holding Stage Cycling Stage Post-PCR Read (Holding Stage)! -
MNumber of Cycles:
[[] Enable AutoDelta
Starting Cycle: l:'
100 —| g50°C 95.0°C
10:00 100% 00:15
T 60.0°C 00% \WSK 60.0°C 60.0°C
50— ST I LA 01:00 100%  p3n
N 00% 02:00
o — 5 -
Legend
Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off ‘
a MNote: Setthe temperatures for the pre-PCR read and post-PCR read o the same value for accurate analysis
Design  When you design your own presence/absence experiment:
Guidelines * Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.
» Review the thermal profile to make sure that it is appropriate for your reagents.
If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the StepOne software.
Notes
Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for 29

Presence/Absence Experiments




m Chapter 2 Design the Experiment
Set Up the Run Method

» If you are running the experiment on a StepOnePlus instrument and you want to set
a different temperature for one or more of the VeriFlex blocks, you need to:

a. Design your experiment using Advanced Setup instead of the Design Wizard.

b. In the Plate Setup screen (page 28), select the Assign Targets and Samples
tab, select the View Plate Layout tab, then select the Enable VeriFlex"™ Block
checkbox.

IMPORTANT! If you do not select the Enable VeriFlex" Block checkbox in
the Plate Setup screen, you will not be able to set a different temperature for
one or more of the VeriFlex blocks in the Run Method screen.

c. In the Run Method screen, select the Graphical View tab.

d. For each VeriFlex" block you want to change, click the temperature, then enter
the desired value.

Note: You can set a different temperature for one or more of the VeriFlex blocks, or
set each of the VeriFlex blocks to the same temperature. If neighboring VeriFlex
blocks are not set to the same temperature, the temperature difference must be
between 0.1 and 5.0 °C. The maximum temperature is 99.9 °C.

For More For more information on:

Information * The run method library or completing the Run Method screen, access the StepOne
Software Help by clicking @ or pressing F1.

» Setting temperatures for the VeriFlex blocks, access the StepOne Software Help by
clicking @ or pressing FIL.

» Using Advanced Setup, see “Advanced Setup Workflow” on page 110.

Notes
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Review the Reaction Setup

On the Reaction Setup screen, select the assay type, then review the calculated volumes
for preparing the samples, controls, and PCR reactions.

IMPORTANT! Perform these steps for each target in the reaction plate.

About the In the presence/absence example experiment:

Example .
Experiment

The assay type is Inventoried/Made to Order

* The reaction volume per well is 20 uL with a 10% excess.

The reaction components are:

TagMan Universal PCR Master Mix (2.0X)
IPC Mix (10X)

IPC DNA (50X)

Primer/Probe Mix (20.0X)

Water

For all samples:

The stock concentration of sample DNA is 100.0 ng/pL.
The sample DNA is diluted to a concentration of 50.0 ng/uL.

— The diluted sample DNA (50.0 ng/uL) is at a 10X concentration: 2 pL is used to

prepare a 20-uL reaction.
The final concentration of sample DNA in the reactions is 5.0 ng/uL.

Complete the Complete the Reaction Mix Calculations Tab

Reaction Setup
Screen

o > © Db

Notes

—h

Select the Reaction Mix Calculations tab (default).

Make sure the Assay Type field displays Inventoried/Made to Order.

Make sure the Reaction Volume Per Well field displays 20 pL.

Make sure the Excess Reaction Volume field displays 10%.

In the Reaction Mix Pane:

a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Primer/Probe Mix Concentration field displays 20.0X.

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
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c. Review the components and calculated volumes for the PCR reactions:

Volume (pL) for
Component Volume (u!.) for 48 Reactions
1 Reaction -
(Including Excess)
Master Mix (2.0X) 10.0 528.0
10X IPC Mix 2.0 105.6
50X IPC DNA 0.4 21.1
Primer/Probe Mix (20.0X) 1.0 52.8
H,O 4.6 242.9
Total Volume 18.0 950.4
2 3 4
2D. Set Up: Reaction Setup Reaction Sstup Help )
a Instructions: 233;&129;;?3?';;29&‘1:\:‘snéreqv:qeov\:rlthoepc‘Z\;;I\.:t;devpuglgnzzf;iwaﬂipalmgIhe PCR reactions. If needed, edit tF|e reaction volume, excess samples, and/or component concentrations. Click "Print Reaction
Assay Type [Inventoried/Mads to Order +|  Reaction Volume Per Well UL Excess Reaction Volume 10 % | Print Reaction Setup |
1 "Reaction Mix Calculations Sarnple Dilution Calculations
Reaction Mix
Master Mix Concentration: 2.0 X Primer/Prabe Mix Concentration: 20‘0 X
5b ‘ Component Final Concentration Volume (uL) for 1 Reaction Volume (L) for 48 Reactions
1% 10.0 528.0
50-800 nit 2.0 1056
50-800 nit 0.4 211
5 50-250 Nt 1.0 528
" Control & Sample Volume
Well Type Component Volume (uL) for 1 Reaction #of Wells Total Volume (uL) Added Per Well Type
Megative Contral-Blocked IPC 10X IPC Block 2.0 4 88 &
Megative Contral-IPC 1X TE or Water 2.0 4 88
Unknawn 1 Sample DMA (10X 2.0 8 17.6 o
6. In the Control & Sample Volume pane, review the calculated volumes for preparing
the reactions:
Volume (pL) Total Volume
Well Type Component for 1 # of Wells (uL) Added
Reaction per Well Type
Negative 10X IPC Block 20 4 8.8
Control-
Blocked IPC
Negative 1X TE or Water 2.0 4 8.8
Control-IPC
Unknown 1 Sample DNA (10X) 2.0 8 17.6
Unknown 2 Sample DNA (10X) 2.0 8 17.6
Notes
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Volume (pL) Total Volume
Well Type Component for 1 # of Wells (uL) Added
Reaction per Well Type
Unknown 3 Sample DNA (10X) 2.00 8 17.6
Unknown 4 Sample DNA (10X) 2.00 8 17.6
Unknown 5 Sample DNA (10X) 2.00 8 17.6

Complete the Sample Dilution Calculations Tab
1. Select the Sample Dilution Calculations tab.

2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then enter
50.0.

3. From the unit dropdown menu, select ng/pL (default).

4. Review the calculated volumes for the sample dilutions:

Sample Stock Sample Diluent Total Volume
Narr?e Concentration Volumep L) Volume (L) of Diluted
(ng/uL) Sample (uL)
Unknown 1 100 9.0 9.0 18.0
Unknown 2 100 9.0 9.0 18.0
Unknown 3 100 9.0 9.0 18.0
Unknown 4 100 9.0 9.0 18.0
Unknown 5 100 9.0 9.0 18.0
2D. Set Up: Reaction Setup Reaction Setup Help e,
a Instructions: Selectthe assay type, then review the calculated volumes for preparing the PCR reactions. If needed, editthe reaction volume, excess samples, andior component
" concentrations. Click "Print Reaction Setup” to print instructions on how to prepare the PCR reactions
1 Assay Type Inventoried/Made to Order |+ Reaction Volume Per Well: 20 | uL Excess Reaction Volume: 10| % | Print Reaction Setup
|
2 | [ Reaction Mix Calculations T Sample Dilution Calculations }
3 | H Diluted Sample Concentration (10X for Reaction Mix): 50.0 | \ng/uL &
Sample Name Stock Concentration (ngfpl) Sample Volume (L) Diluent Volume (pL) Total Volume of Diluted Sample.
(] unknown 1 [ 100.0 | 9.0 9.0 180
Unknown 2 [ 100.0 | 9.0 9.0 18.0
4 — Unknown 3 [ 100.0 | 9.0 9.0 18.0
Unknown 4 [ 100.0 | 9.0 9.0 18.0
Unknown § [ 100.0 | 9.0 9.0 18.0
Notes
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Print Reaction Setup Instructions

Print detailed reaction setup instructions, then save the instructions for Chapter 3.

1. Click Print Reaction Setup.

2D. Set Up: Reaction Setup Reaction Setup Help e,

Selectthe assay type, then review the calculated volumes for preparing the PCR reactions. If needed, edit the reaction volume, excess samples, and/or component

Instructions:
a nstructions concentrations. Click "Print Reaction Setup” to print instructions on how to prepare the PCR reactions,

—_

Assay Type Inventoried/Made to Order Reaction Volume Per Well: 20 WL Excess Reaction Volume: 10| % | Prirt Reaction Setup | —

J Reaction Mix Calculations I Sample Dilution Calculations }

2. In the dialog box, select:
* Detailed Reaction Setup Instructions
* Include Plate Layout
e Use sample color

3. Click Print to send the reaction setup instructions to your printer.

Print Reaction Setup Instructions ﬁ\

a Select the type of instructions to print

© summary Reaction Setup Instructions
(®) Detailed Reaction Setup Instructions
Ineiude Plate Layout

Plate Layout Print Options

| (& Use sample color

(O Use task color

Preview ‘ | Print | ‘ Cancel

4. Click Next.

Design  When you design your own presence/absence experiment:

Guidelines + Select the type of assay you are using:

— Inventoried/Made to Order— The primers and TagMan probe are provided
together in one ready-to-use assay mix.

— Custom— The primers and TagMan probe are designed and provided separately.

* Enter a number from 10 to 30 for the reaction volume/well. The StepOne and
StepOnePlus systems support reaction volumes from 10 to 30 pL.

* Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

* Review the components and calculated volumes for the PCR reactions. If needed,
edit the master mix and primer/probe mix concentrations.

For More For more information on completing the Reaction Setup screen, access the StepOne
Information Software Help by clicking @ or pressing F1.

Notes
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Order Materials for the Experiment

On the Materials List screen, review the list of materials recommended to prepare the
PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order
the recommended materials from the Applied Biosystems Store.

Note: To access the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The StepOne software recommends the materials to order based on your
experiment design. It is assumed that you will design your experiment, order your
materials, then prepare (Chapter 3) and run (Chapter 4) the reaction plate when your
materials arrive.

About the In the presence/absence example experiment, the recommended materials are:
Exa_mple + MicroAmp"" Fast Optical 48-Well Reaction Plate
Experiment . ™ . L
* MicroAmp = 48-Well Optical Adhesive Film
+ MicroAmp™™ 96-Well Support Base
+ TagMan® Universal PCR Master Mix (2X)

Note: The example experiment was created for a StepOne instrument. If you selected the
StepOnePlus instrument in the Experiment Properties screen (page 20), the 96-well
consumables (for example, the MicroAmp" Fast Optical 96-Well Reaction Plate) are
listed in place of the 48-well consumables.

Complete the 1. From the Display dropdown menu, select All Items (default), then review the

Experiment recommended materials. If needed, use the scroll bar at right to see all items.
Materials List
Screen Note: For more information on a specific item, click the part number link. You will

be connected to the product information page on Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

2. (Optional) Click Print Materials List to send the materials list to your printer.

3. (Optional) Create a shopping list:

a. Select the checkbox next to each of the following items:
+ MicroAmp"" Fast Optical 48-Well Reaction Plate
» MicroAmp"™ 48-Well Optical Adhesive Film
+ MicroAmp"™ 96-Well Support Base
+ TagMan® Universal PCR Master Mix (2X)

b. Click Add Selected Items to Shopping List.

Notes
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4. (Optional) Create a shopping basket on the Applied Biosystems Store:

Note: To access the Applied Biosystems Store, you need to have an Internet
connection. Product availability and pricing may vary according to your region or
country. Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Login and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

5. Go to “Finish the Design Wizard” on page 38.

3A. Order: Materials List (Optional) Materials List Help @
a Instructions: eView the list of materials recommended to prepare the PCR reaction plate. To create a shopping hasket on the Applied Biosystems Store, add items to the shopping
" list, enter a name forthe shopping hasket, click "Order Materials in List" then log in.
Experiment Materials List 1
|
| | Add Selected tems to Shopping List | Display: |All ltems v | Print Meterials List | ” 2
‘ [ check Al Item Part Number Description
The MicroAmp™ Fast Optical 48-Well Reaction Plate, constructed A
MicroAmp™ Fast Optical 48-Well Reaction Plate... 4375816 from a single rigid piece of polypropylens ina 48-well format.
Increased thermal contact for faster, more uniform heating
An optically-clear adhesive film used to seal the samples into the
) - g ) wells of a microplate. This will reduce the possihility of
MicroAmpT Optical 48-Wall Adhesive Film (100 4376303 cross-contamination between sample wells and help ensure v
Experiment Shopping List (3 items)
‘ Remove Selected tems from Shopping List ‘ Shopping Basket Name | Presence Absence Example StepOne ‘ Oreler Materials in List i 4a
[1 Check All Item Part Mumber Quantity
R MicraAmpT™ 96-Well Support Base (10 bases) 4378590 [ |
R MicroAmp™ Fast Optical 48-Well Reaction P 4375816 [ |
R MicraAmp™ Optical 48-Well Adhesive Film (.. 4375373 [ |
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Design  When you design your own presence/absence experiment:
Guidelines * Select all the materials you require for your experiment and add them to your
shopping list.
» To access the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Applied Biosystems recommends the following browsers and Adobe® Acrobat®
Reader versions to use the Applied Biosystems web site:

Desktop ® Microsoft® . ® Adobe®
Operating "ll\le;\ff?:zr Internet MatS:Iar}Lc:ish Acrobat®
System 9 Explorer Reader
Windows® v6.x or later v6.x or later Not applicable v4.0 or later
2000/NT/XP/Vista

Macintosh® OS Not supported | Not supported | v2.0.4 or later v4.0 or later
9+ or later

Note: Make sure that cookies and Java Script are turned on for the web site to
function correctly.

For More For more information on completing the Experiment Materials List screen, access the
Information StepOne Software Help by clicking @ or pressing F1.

Notes
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Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About The The StepOne software automatically selects locations for the wells in the reaction plate.
Example In the presence/absence experiment:

Experiment » The wells are arranged as shown below.

eview Plate Layout for Experiment "Presence Absence Example”

) Reviswthe plate layout, then sslect what you wantto do nexl
Save Experiment Start Run for This Experiment Edit Plate Layout Cres:te Another_E)(penment Return to the Wizard
Using the Design Wizard
Save and close this Save this experiment, then  Use Advanced Setup to edit Save and close this Continue designing this
experiment startthe run. Make sure the the plate layout experiment, then create  experiment using the Design
reaction plate is loaded into another experiment using the Wizard.
the instrument. Design Wizard.
| ElshumeEIISV | View Legend ‘ | | |
i | : \ 3 | 4 | 5 \ 5 | 7 | 8 |
[ Pathagen [ Pathogen [ Pathagen [ Pathagen [ Pathogen [ Pathagen [ Pathagen [ Pathogen
A e A e [ e A e I rc (T 5 T [ I rc
Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1
B Pathagen [ Pathogen Pathogen Pathagen [ Pathogen Pathogen Pathagen [ Pathogen
[T [ H e i irc [T [ H e i irc [T [ H e
Unknawn 2 Unknawn 2 Unknawn 2 Unknawn 2 Unknawn 2 Unknawn 2 Unknawn 2 Unknawn 2
¢ | [ Pathogen [0 Pathogen [ Pathogen [ Fsthogen [0 Pathogen [ Pathogen [ Fsthogen [0 Pathogen
[T i3 H e T I [T i3 H e T I [T i3 H e
Unknawn 3 Unknawn 3 Unknawn 3 Unknawn 3 Unknawn 3 Unknawn 3 Unknawn 3 Unknawn 3
o | [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen
il e I rc il irc il e I rc il irc il e I rc
Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4
E Pathagen [ Pathogen Pathogen Pathagen [ Pathogen Pathogen Pathagen [ Pathogen
[T [ H e i irc [T [ H e i irc [T [ H e
Unknawn & Unknawn 5 Unknawn & Unknawn & Unknawn 5 Unknawn & Unknawn & Unknawn 5
¢ | [ Pathogen [0 Pathogen [ Pathogen [ Fsthogen [0 Pathogen [ Pathogen [ Fsthogen [0 Pathogen
[T i3 H e T I [T i3 H e T I [T i3 H e

Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 20),
your reaction plate layout will differ from the layout shown above. The software
displays a 96-well reaction plate layout for the StepOnePlus instrument. For an
example of the 96-well reaction plate layout, see page 11.

* The experiment is saved as is and closed.

Note: For the example experiment, do not perform the run at this time.

Notes
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Finish the Design Wizard

Finish the 1. At the bottom of the StepOne software screen, click Finish Designing Experiment.
Design Wizard

2. In the Review Plate for Experiment window, review the plate layout. Make sure
there are:

* 40 Unknown-IPC @

* 4 Negative Control-Blocked IPC &l [
+ 4 Negative Control-IPC [l

* 0 Empty

Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.

3. Click Save Experiment.

4. In the Save Experiment dialog box, click Save to accept the default file name and
location. The example experiment is saved and closed, and you are returned to the
Home screen.

Note: By default, the example experiment is saved to the <drive>:\Applied
Biosystems\<software name>\experiments folder.

£ Save Experiment Presence Absence Example

Save in: |@ experiments v| \_mljl\a

'2 E) examples:

My Recent
Documents

&)

Desktop

o

My Documents

My;‘r:?mer
'g File name ‘ Presence Absence Example eds | ‘KJ
My Network
Places Files oftype: ‘Experimem Document Single files (*.eds) V| | cancel
Notes
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Design
Guidelines

When you design your own presence/absence experiment:

* In the Review Plate for Experiment window, select the appropriate exit option:

Click

if you want to...

Save Experiment

save and close the experiment without making any
further changes or starting the run.

Start Run for This Experiment

Edit Plate Layout

Create Another Experiment Using

the Design Wizard

save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

¢ use advanced setup to edit the plate layout.

e (StepOnePlus instrument only) set a different
temperature for one or more of the VeriFlex blocks
using Advanced Setup.

save and close the current experiment, then create

another experiment using the Design Wizard.

Return to the Wizard

return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to the <drive>:\Applied Biosystems\<software
name>\experiments folder. To change the:

— Save location for a specific experiment, navigate to the desired location using the

Save Experiment dialog box.

— Default save location, select Tools » Preferences, then select the General tab
(default). In the Default Data Folder field, browse to the desired location.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on

Information page 110.
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Prepare the Reactions

This chapter covers:

B Chapter OVeIrVIEW . . . oottt e e e e e e 42
B Prepare the Template. . .. ... .. 43
B Prepare the Samples . . ... ... 44
B Prepare the Reaction MiX . . ... .. it i 46
B Preparethe Reactions . ......... ... . .. . .. 48

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to prepare the PCR reactions for the presence/absence
example experiment and provides guidelines for how to prepare the PCR reactions for
your own presence/absence experiment.

Example The workflow for preparing the PCR reactions for the example experiment provided with
Experiment this getting started guide is shown below.
Workflow

Start Experiment

v
Design the Experiment (Chapter 2)
v

Prepare the Reactions (Chapter 3)

Prepare the template.
Prepare the samples.

Prepare the reaction mix.

o Dd =

Prepare the reactions.

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

End Experiment

Notes
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Prepare the Template

In this section, prepare the DNA template for the PCR reactions using the PrepMan®
Ultra Sample Preparation Reagent kit.

About the For the presence/absence example experiment, the template for the PCR reactions is
Example DNA extracted from bacteria found in ground beef. There are 5 samples of ground beef
Experiment to analyze for the presence or absence of a pathogen.

Required « DNA isolated from blood, tissue culture cells and buccal swabs.
Materials « DNA isolated from animal or plant tissue.

Purified plasmid DNA.

* One of the products listed below for DNA isolation:

Kit¥ Part Number
PrepMan® Ultra Sample Preparation Reagent kit 4322547
NucPrep® DNA Chemistry for Tissues 4340274
BloodPrep® Chemistry for Blood, Tissue Culture Cells, 4346860
and Buccal Swabs
Plasmid Miniprep Kit 402790

t Applied Biosystems recommends using the kits with the ABI PRisM® 6100 Nucleic Acid
PrepStation or the ABI PRisM® 6700 Nucleic Acid Automated Workstation.

Prepare the Use the DNA isolation kits recommended in the table above, or follow your own protocol
Template toisolate DNA.

Preparation When you prepare your own presence/absence experiment, extract DNA from the tissue
Guidelines or sample. Ensure that the DNA you use:

* Has a A,q)5 ratio of greater than 1.7.

* Has a stock concentration of 100 ng/uL.

 Is extracted from the raw material you are testing using an optimized protocol.
* Does not contain PCR inhibitors.

 Isintact as visualized by gel electrophoresis.

* Has not been heated above 60 °C.

Notes
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Prepare the Samples

For More Applied Biosystems supplies several chemistries for isolating DNA from blood, tissue,
Information cell cultures, plant material, and food. For more information refer to:

DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal
Swabs Protocol

NucPrep®™ Chemistry Isolation of Genomic DNA from Animal and Plant Tissue
Protocol

PrepMan® Ultra Sample Preparation Reagent Protocol

Prepare the Samples

In this section, dilute the DNA samples using the volumes that were calculated by the
StepOne™” software.

About the For the presence/absence example experiment, 2 pL of 50 ng/uL sample DNA is added to
Example 18 pL of Reaction Mix. The final reaction volume per well is 20 pL. For all wells
Experiment containing sample DNA, the final concentration of DNA per well is 5 ng/uL, and the
total amount of DNA per well is 100 ng.

For the presence/absence example experiment:

L]

The stock concentration of sample (Unknown) DNA, after preparing the template, is
100 ng/uL.

The desired concentration of sample (Unknown) DNA to add to the reaction is
50 ng/uL.

The reaction volume per well is 20 pL.

The excess reaction volume is 10%.

The volumes calculated in the software are:

Sample | GonContration | SamPle Diluent " E i ed
Name (ng/uL) Volume (pL) Volume (pL) Sample (uL)
Unknown 1 100 9.0 9.0 18.0
Unknown 2 100 9.0 9.0 18.0
Unknown 3 100 9.0 9.0 18.0
Unknown 4 100 9.0 9.0 18.0
Unknown 5 100 9.0 9.0 18.0
Required « Buffer or water to dilute the sample
Materials  Microcentrifuge tubes
* Pipettors
* Pipette tips
» Sample stock
* Vortexer
Notes
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* Centrifuge

Prepare the 1. Label a separate microcentrifuge tube for each unknown sample:
Sample Dilutions « Unknown 1

e Unknown 2
* Unknown 3
e Unknown 4
e Unknown 5

2. Add the required volume of water to each empty tube:

Tube sﬁ:‘nﬂe vﬂﬁZ"(LL)
1 | Unknown 1 | 9.0
2 Unknown 2 9.0
3 Unknown 3 9.0
4 Unknown 4 9.0
5 Unknown 5 | 9.0

3. Add the required volume of sample stock to each empty tube:

e Somhe s
1 Unknown 1 9.0
2 Unknown 2 9.0
3 Unknown 3 | 9.0
4 Unknown 4 | 9.0
5 Unknown 5 | 9.0

4. Vortex each sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reactions.

Notes
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Prepare the Reaction Mix

Notes
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About the
Example
Experiment

Required
Materials

Prepare the
Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
StepOne software (“Complete the Reaction Mix Calculations Tab” on page 31).

Note: The reaction mix includes all components except sample or negative control
(buffer or IPC blocking agent).

All samples contain a primer and probe set for the IPC and a primer and probe set for the
pathogen, therefore, only one reaction mix is required.

The reaction mix components and volumes calculated in the software are:

Component Vo:u;;zgiilgr:or

TagMan® Universal PCR Master Mix 10.00
(2.0X) or TagMan® Universal PCR

Master Mix, No Amperase® UNG

10X IPC Mix | 2.00
50X IPC DNA 0.40
20X pathogen mix 1.00
Water/Buffer 4.60
Total Reaction Mix Volume | 18.00

Note: The sample is not added at this time.

* Microcentrifuge tubes

* Pipettors

* Pipette tips

* Reaction mix components (listed above)
* Centrifuge

ACAUTION CHEMICAL HAZARD. TagMan Universal PCR Master Mix

may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

A (o7 1[o)\] CHEMICAL HAZARD. TagMan 2X Universal PCR Master

Mix, No AmpErase UNG may cause eye and skin irritation. Exposure may cause
discomfort if swallowed or inhaled. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.
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Prepare the Reaction Mix

1. Label an appropriately sized tube for the reaction mix: Pathogen Reaction Mix.

2. Add the required volumes of each component to the tube:

Volume for
Component YO Roaction | (nclucing Excess)
(L)

TagMan® Universal PCR Master Mix 10.00 528.0

(2.0X)

10X IPC Mix 2.00 105.6

50X IPC DNA 0.40 211

20X pathogen mix | 1.00 52.8
Water/Buffer | 4.60 242.9

Total Reaction Mix Volume | 18.00 950.4

3. Mix the reaction mix by gently pipetting up and down, then cap the tube.
4. Centrifuge the tube briefly.

5. Place the reaction mix on ice until you prepare the reactions.

Preparation When you prepare your own presence/absence reactions:

Guidelines * Prepare the reaction mix for each target separately.

* Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers.

* Include all required components.
* Prepare the reagents according to the manufacturer’s instructions.

» Keep the TagMan probe protected from light, in the freezer, until you are ready to
use it. Excessive exposure to light may affect the fluorescent probes.

* Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Notes
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Prepare the Reactions

Prepare the reactions using the volumes that were calculated by the StepOne software.
See “Review the Reaction Setup” on page 31.

About the For the presence/absence experiment:
Example « A MicroAmp'" Optical 48-Well Reaction Plate is used.

Experiment . . .
P The final concentration of DNA for all of the samples is 5 ng/uL.
* The reaction volume is 20 uL/well.
* The reaction plate contains:
— 4 Negative Control-Blocked IPC E [
— 4 Negative Control-IPC [
— 40 Unknown-IPC [
— 0 Empty
» The plate layout automatically generated by the StepOne software is used:
+ Review Plate Layout for Experiment "Presence Absence Example™
a Review the plate layout, then select what you want to do next.
‘ Save Experiment ‘ Start Run for This Experiment ‘ Eclit Plate Layout ‘ Crues?‘eg';‘n:t;:;i::w;::? ‘ Return to the Wizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment, start the run. Make sure the the plate layout, experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard.
the instrument. Design Wizard.
| [3 show in wells w | [ view Legend ‘ | |
i | 2 \ 3 | 4 | 5 \ 8 | 7 | 8 |
D Pathogen D Pathogen D Pathogen D Pathogen D Pathogen D Pathogen D Pathogen D Pathogen
A IFC \PC IPC IFC n\F‘C IPC IFC n\F‘C
B Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1 Unknown 1
B m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen
il e I rc il irc il e I rc il irc il e I rc
B Unknown 2 Unknown 2 Unknown 2 Unknown 2 Unknown 2 Unknown 2 Unknown 2 Unknown 2
c Pathagen [ Pathogen Pathogen Pathagen [ Pathogen Pathogen Pathagen [ Pathogen
[T [ H e i irc [T [ H e i irc [T [ H e
N Unknown 3 Unknown 3 Unknown 3 Unknown 3 Unknown 3 Unknown 3 Unknown 3 Unknown 3
o | [ Pathogen [0 Pathogen [ Pathogen [ Fsthogen [0 Pathogen [ Pathogen [ Fsthogen [0 Pathogen
[T i3 H e T I [T i3 H e T I [T i3 H e
B Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4 Unknown 4
E m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen m Pathogen
il e I rc il irc il e I rc il irc il e I rc
B Unknown 5 Unknown 5 Unknown 5 Unknown 5 Unknown 5 Unknown 5 Unknown 5 Unknown 5
F Pathagen [ Pathogen Pathogen Pathagen [ Pathogen Pathogen Pathagen [ Pathogen
[T [ H e i irc [T [ H e i irc [T [ H e
Note: The example experiment was created for a StepOne instrument. If you
selected the StepOnePlus instrument in the Experiment Properties screen (page 20),
your reaction plate layout will differ from the layout shown above. The software
displays a 96-well reaction plate layout for the StepOnePlus instrument. For an
example of the 96-well reaction plate layout, see page 11.
Notes
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Prepare the Reactions

Required * Pipettors
Materials « Pipette tips
» Pathogen reaction mix (from page 46)
* Water or buffer
» Samples (from page 45)
+ MicroAmp"" Fast Optical 48-Well Reaction Plate
+ MicroAmp"™ Optical 48-Well Adhesive Film
* Centrifuge

Prepare the Use the plate layout and instructions to prepare the PCR reactions. Make sure the
Reactions arrangement of PCR reactions matches the plate layout in the software:

1. Add 18 pL of reaction mix to the appropriate wells.

Reaction Mix Add 18 pL Reaction Mix to Wells

Pathogen A1, A2, A3, A4, A5, A6, A7, A8
B1, B2, B3, B4, B, B6, B7, B8,
C1, C2, C3, C4, C5, C6, C7, C8
D1, D2, D3, D4, D5, D6, D7, D8
E1, E2, E3, E4, E5, E6, E7, E8
F1, F2, F3, F4, F5, F6, F7, F8

2. Prepare Negative Control-IPC reactions (Task = NC-IPC): Add 2 uL of buffer or
water to the appropriate wells.

Add 2 pL Buffer or Water to Wells

A5, A6, A7, A8

3. Prepare Negative Control-Blocked IPC reactions (Task = NC-Blocked IPC): Add
2 puL of IPC blocking agent to the appropriate wells.

Add 2 pL Blocking Agent to Wells

A1, A2, A3, A4

4. Prepare unknown reactions (Task = Unknown): Add 2 puL of sample to the
appropriate wells.

Sample Add 2 L Sample to Wells
Unknown 1 B1, B2, B3, B4, B5, B6, B7, B8
Unknown 2 C1,C2,C3, C4, C5, C6, C7,C8
Unknown 3 D1, D2, D3, D4, D5, D6, D7, D8
Unknown 4 E1, E2, E3, E4, E5, E6, E7, E8
Unknown 5 F1, F2, F3, F4, F5, F6, F7, F8
Notes
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5. Cover the reactions according to the plastic consumables you are using:
* Optical reaction plate: Seal the reaction plate with optical adhesive film.
+ Tube strips: Cover the tubes with caps.

6. Centrifuge the tubes briefly to remove air bubbles.

7. Confirm that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
g
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. | o Not centrifuged for enough time

8. Until you are ready to perform the run, place the reaction plate on ice in the dark.

Preparation When you prepare your own presence/absence experiment:
Guidelines * Wear appropriate protective eyewear, clothing, and gloves.
* Make sure you use the appropriate consumables.

* Make sure the arrangement of the PCR reactions matches the plate layout in the
StepOne software. You can either:

— Accept the plate layout automatically generated by the StepOne software.
or
— Use Advanced Setup to change the plate layout in the software.

» Ifyou use optical adhesive film to seal your reaction plates, seal each reaction plate
as follows:

Example
Action
StepOne™ System StepOnePlus™ System

1. Place the reaction plate onto the center of the 96-well base. Be sure the reaction plate is flush with the top surface of the
96-well base.

2. Load the reaction plate as desired. ‘

Notes
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Example
Action
StepOne™ System StepOnePlus™ System

3. Remove a single optical adhesive film (film) from the box. QL

* for the StepOne system reaction plate, bend both end-tabs =
upward. Hold the film backing side up. « >

e For the StepOnePlus system reaction plate, fold back one of
the end-tabs. Hold the film backing side up.

4. In one swift movement, peel back the white protective backing
from the center sealing surface. Do not touch the center
sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may
result in haziness, but will not affect results. Haziness will
disappear when the film comes into contact with the heated cover
in the instrument.

5. Holding the film by the end-tabs, lower the film onto the
reaction plate (adhesive side facing the reaction plate). Be sure
the film is completely covering all wells of the reaction plate.

6. While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the reaction
plate.

7. While using the applicator to hold the edge of the film in place,
grasp one end of the end-tab and pull up and away sharply.
Repeat for the other end-tab.

8. To ensure a tight, evaporation-free seal:
a. Repeat step 6.
b. While applying firm pressure, run the edge of the applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the application of pressure to ensure a tight,
evaporation-free seal.

9. Inspect the reaction plate to be sure all wells are sealed. You should see an imprint of all wells on the surface of the film.

For More For more information on:
Information * Consumables, see “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout, see “Advanced Setup Workflow”
on page 110.

Notes
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Prepare the Reactions

Notes
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n Run the Experiment

This chapter covers:

B Chapter OVeIrVIEW . . . oottt e e e e e e 54
B Prepare forthe Run. .. ... ... ... .. .. . . . 55
B (Optional) Enable the Notification Settings . . ... ............ .. ... ........ 57
B Startthe Run. . ....... .. . 59
B Monitorthe Run . ... ... ... 63
B Unload the Instrument and Transferthe Data. . ........................... 70

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems StepOne™ and
StepOnePlus™ Real-Time PCR Systems.

Example The workflow for running the example experiment provided with this getting started
Experiment guide is shown below.

Workflow
Start Experiment

h 4
Design the Experiment (Chapter 2)

v
Prepare the Experiment (Chapter 3)

h 4
Run the Experiment (Chapter 4)

Prepare for the run.
(Optional) Enable the notification settings.
Start the run.

Monitor the run.

o > 0D =

Unload the instrument and transfer the data.

v
Analyze the Experiment (Chapter 5)

h 4
End Experiment

Notes

54 Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for
Presence/Absence Experiments



Chapter 4 Run the Experiment n
Prepare for the Run

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the StepOne™™ or StepOnePlus™ instrument.

Open the 1. Double-click g (StepOne software shortcut) or select
Example Start » All Programs » Applied Biosystems » StepOne Software »
Experiment <software name>

where <software name> is the current version of the StepOne software.
2. From the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click Presence Absence Example to open the example experiment file you
created in Chapter 2.

File Edit Instrument Analysis Tools Help I

2 Ty mew expenEm < Ly Open. [ N JJ Send Experiment to Instrument L_Yi. Download Experiment from Instrument.. 48 Y
Analyze
E‘ e Experiment
3 Counn ) experiments v BEEE
. ) examples
4 : [#] Presence Absence Example.eds

My Recent
Documents

My Computer

°
File name

My Network
Places Files oftype: a1l SDS Files (edm; eds; edt)

Notes
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Prepare for the Run

Load the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. If the instrument has been used
Into the recently, keep your hands away until the sample block(s) reach room temperature.
Instrument

# IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Open the instrument drawer.

StepOne instrument StepOnePlus
sample block instrument VeriFlex™
Sample Blocks

2. Place the reactions in the sample block(s):

» If using a reaction plate: Place the reaction plate in the sample block(s) with
well A1 at the back-left corner.

» If using reaction tube strips: Place the tray containing the tube strips in the
sample block(s).

 [f using reaction tubes: Place the tray containing the tubes in the sample
block(s).

Notes
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(Optional) Enable the Notification Settings

IMPORTANT! For optimal performance with partial loads:

StepOnePlus instruments - Load at least 16 tubes and arrange them in:

* Adjacent columns of 8 tubes, using rows A through H. For example, fill wells
in column 1 (rows A through H) and column 2 (rows A through H).

or

* Adjacent rows of 8 tubes, using columns 3 through 10. For example, fill wells
in row A (columns 3 through 10) and row B (columns 3 through 10).

StepOne instruments - Load at least 4 tubes in the sample block.

3. Close the instrument drawer carefully.

éCAUTION

(Optional) Enable the Notification Settings

Enable the notification settings so that the StepOne software alerts you via email when
the StepOne or StepOnePlus instrument begins and completes the run, or if an error
occurs during the run. Enabling the notifications settings feature is optional and does not
affect the performance of the StepOne™ and StepOnePlus™ systems or the duration of
the run.

IMPORTANT! The notification settings feature is available only if the computer that you
are using is running the StepOne or StepOnePlus instrument and is connected to an
Ethernet network.

Note: The notification system is also available to computers that are monitoring a
StepOne or StepOnePlus instrument remotely. For more information, see “Remote
Monitor” on page 67.

About the In the example experiment:

Exa_.mple * The StepOne software is set up to send notifications to three users (scientist,
Experiment supervisor, and technician at mycompany.com) when the StepOne or StepOnePlus
system ends the run and if it encounters any errors during operation.

e The example SMTP server (www.mycompany.com) is set up for Secure Sockets
Layer (SSL) encryption and requires authentication for use.

Notes
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Set Up the
Notification
Settings

1. In the StepOne software, click @ Run in the navigation pane.
Click 5 Notification Settings.

Select Yes for Enable Notifications.

P 0D

Select the events that will trigger notifications:
a. Select Instrument Error.

b. Select Run Completed.

5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. Inthe Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Set the authentication settings:
a. Select Yes for Server requires authentication.
b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notification Settings

[1Run Started
Run Completed

Enter e-mail addresses for notifications: |scientist@mycompany.com, superisor@mycompany.com, technician@rmycompany.com

Outgoing Mail Server (SMTP): | smitp.mycormpany.com
For example: smtp.mycompany.com

3 1
Enablz Notifications: & Yes O Mo
Selectthe events to generate notifications Instrument Error
Separate e-mail addresses with commas
For example: jane_smith@mydamain.com,awong@bigmailhost.com
7a Server requires an encrypted connection? OYes & No
|
Semer requires authentication? & Yes O No
7b (Server Authentication) User Name: | Example User
7c (Server Authentication) Password: Wwwwwwwwl

Run Guidelines

Notes

58

When you set up the StepOne or StepOnePlus system for automatic notification:

* Your system must be set up for network use. Refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

* Select the events for which you want to receive e-mail notifications:

— Instrument Error — When selected, recipients are e-mailed all errors
encountered by the instrument during each run.

— Run Started — When selected, recipients are e-mailed every time the instrument
starts a run.
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Start the Run

— Run Completed — When selected, recipients are e-mailed every time the
instrument completes a run.

¢ Obtain e-mail addresses to receive notifications.

IMPORTANT! Separate addresses with a comma (,).

* Contact your systems administrator or information technology department if you
need:

— E-mail addresses for users who will receive notifications

— A network address for a simple mail transfer protocol (SMTP) server on the LAN

A user name and password for the server, if required for access

The Secure Sockets Layer (SSL) setting of the server (on or off)

Start the Run

Start the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Startup”
instrument below
Standalone e The computer and the instrument are not “Standalone Startup”
connected, or on page 60
e The computer and the instrument are
connected to the same network.

Colocated Perform this procedure if your computer is directly connected to your StepOne or
Startup  StepOnePlus instrument by the yellow cable.

1. In the StepOne software, click % Run in the navigation pane.
2. Click START RUN J¢.

2

' Setup
Wig
“L Run

1 Instrument Status: @& Connected

L
—
e cetio i Run Status:  Not Started Enable Notifications

Notes
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Standalone Perform these procedures if your computer and StepOne or StepOnePlus instrument are
Startup not directly connected by the yellow cable. Start with:

* “Send the Experiment to the Instrument Over the Network™ on page 60 if your
computer and instrument are connected to the same network.

or

* “Transfer the Experiment to the Instrument Using a USB Drive” on page 60 if your
computer and instrument are not connected to the same network.

Send the Experiment to the Instrument Over the Network

1. In the StepOne software, click ;] Send Experiment to Instrument.

2. In the Send Experiment to Instrument dialog box:
a. Click Browse, navigate to the example experiment file, then click Open.
b. Select the instrument to receive the experiment file.
Note: If your instrument is not listed, set up the instrument for monitoring as

explained in the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time
PCR Systems Installation, Networking, and Maintenance Guide.

c. Click Send Experiment to send the experiment to the your instrument over the

network.
Send Experiment to Instrument g|
a Selectan experimentto send, selectthe instrument to receive the experiment, then click
"Send Experiment” OJ
2a —1 1 select Experiment | Browse
2b 1 2 Selectinstrument. % Local Instrument (Default) v

20 : Send Experiment | Cancel

3. When prompted, click OK to close the confirmation.

4. Go to “Start the Instrument Run Using the Touchscreen” on page 61.

Transfer the Experiment to the Instrument Using a USB Drive
1. Connect the USB drive to one of the USB ports on the computer.
2. 1In the StepOne software, select [ Save » Save As.

3. In the Save dialog box, navigate to the USB drive, then click Save.

Notes
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Start the Run

4. Remove the USB drive from your computer, then connect it to the USB port of your
StepOne or StepOnePlus instrument.

5. Go to “Start the Instrument Run Using the Touchscreen” below.
Start the Instrument Run Using the Touchscreen
1. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

Wait for the USB sign to appear on the touchscreen.
In the Main Menu screen, touch Browse/New Experiments.

In the Browse screen, touch {fZ) Folders.

o 0O DN

In the Choose an Experiment Folder screen:
* Touch USB if you transferred the experiment on a USB drive.
* Touch Default if you sent the experiment over a network connection.
6. Before starting the run, save the example experiment to your instrument:
a. In the Browse screen, touch the example experiment name, then touch Copy.

b. In the Save Experiment screen, navigate to a destination folder, then click

Save & Exit.
7. In the Browse screen, touch the example experiment name, then touch
[ Start Run.
Notes
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Start the Run
( ﬁ) Browse Last Accessed Experiments (1)
4
Experiment I Folder I Last Used * D'
R o 1ple Experiment Transfer 04
Page
111
6a K
|
7 D I q I / I ma I i l Sele;:ied:
Start Run Mew View/Edit Copy Delete
Touch an experiment to select it, then touch
any of the buttons to perform an action. '*
Touch a column title to sort the table.
8. In the Run Parameters screen:
a. Touch the Reaction Volume field, use the keypad to enter the reaction volume
for the example experiment, then touch Done.
b. Touch Start Run Now.
{ ﬁ) Experiment Parameters
8a Reaction Volume: |20 ul
Cover Temperature: |105_0 o
Experiment Name: IExampIe_Experiment
Start R
8b E;\lowun I
Touch each field then use the keyboard
to edit the contents. When you are finished, ?'
touch Start Run.
Notes
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Monitor the Run

Monitor the run according to the layout of your StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer to the “Colocated Monitoring”
instrument. below
Standalone The computer and the instrument are “Remote Monitor” on
(Networked) connected to the same network. page 67
Standalone The computer and the instrument are not “Standalone Monitoring”
(Basic) connected. on page 69

Colocated If your computer is directly connected to your StepOne or StepOnePlus instrument by the

Monitoring yellow cable, you can view the progress of the run in realtime as described below. During
the run, periodically view all three plots available from the StepOne software for
potential problems.

# To... Action

>

Stop the run 1. In the StepOne software, click STOP RUN.

2. In the Stop Run dialog, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

B | View amplification data | Select w Amplification Plot.

in realtime See “About the Ampilification Plot Screen” on page 64.

C | View temperature data Select [ Temperature Plot.

for the run in realtime See “About the Temperature Plot Screen” on page 65.

D | View progress of the Select |: Run Method.
run in the Run Method See “About the Run Method Screen” on page 66.

screen

E | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 57.

Notes
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i setup | P ]
A ~— Run } Estimated Time Remaining:56 min 22 sec Instrument Status: & Connected
B — Amplification Plot Run Status mn [0 Enable Noftifications E
— Temperature Plot
@ \& L Temperature Plot Current Temperatures
I~ .
D RunMethod a & = = M cover
.Samp\e
Notification Settings Temperature Plot Block
110
100
o0
a0
70
H
£ 80
D
g
E &0
5
=
40
30
20
10 Temperature Plot
P R R ZI = = rar=er e vral | NP
Time
Fixed view []

About the Ampilification Plot Screen

The Amplification Plot screen allows you to view sample amplification as your
instrument collects fluorescence data during a run. If a method is set up to collect real-
time data, the Amplification Plot screen displays the data for the wells selected in the
View Plate Layout tab. The plot contrasts normalized dye fluorescence (ARn) and cycle
number. The figure below shows the Amplification Plot screen as it appears during the
example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in
the View Plate Layout tab.

> "
P Lpay s Selectwelis with: |- select tem - || |

Ampliﬁcation Plot | EI Show inWells ¥ View Legend

¥
¥

1 2 3 4 5 B 7 8

A Hwec [Awrc [Hwrc [Hiec IPC irc [l irc IPC
[0 path [T patn [T Path. [T Patn [T Path, 4 [T Path, [T Path AT path. )

g|drc (Elec (e (e lwec (Elec (Wec (il rc
I path.. [T Path,.. T Patn.. T path . [T Patn.. N0 path... K path, o [T Path.

c|dwrc (Elwec (e (e lwec (Elrc (Wrec (Il rc
I path.. [T Path,.. T Patn.. T path . [T Patn.. N0 path... K path, o [T Path.

pldrc ‘Elwec (lrc (e Elwec (Elec (Wrec (Il rc
I path.. [T Path,.. T Patn.. T path . [T Patn.. N0 path... K path, o [T Path.

2 4 L] a 10 12 14 1@ 1@ 0 2 ¥ ¥ A N B M ¥ W\ N0 c PC IF'C IF’C PC IF'C IF’C PC IF'C
Cycle I path.. [T Path,.. T Patn.. T path . [T Patn.. N0 path... K path, o [T Path.

ARN

{ Legend

A sllcElcN:r p(@rc (lec (e (rec (e (Erec (Wl ec (Il rc
I path.. [T Path,.. T Patn.. T path . [T Patn.. N0 path... K path, o [T Path.

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include the following:

* Increased fluorescence in negative control wells.
Notes
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» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of signal, troubleshoot the
error as explained in the StepOne Software Help (click @ or press F1).

About the Temperature Plot Screen

During a run, the Temperature Plot screen displays the temperatures of the sample
block(s), the heated cover, and samples (calculated) in realtime. The figure below shows
the Temperature Plot screen as it appears during the example experiment.

To... Action

A | Add/remove temperature plots Select Cover or Sample Block to
toggle the presence of the
associated data in the plot.

B | Change the time displayed by plot From the View dropdown menu,
select the amount of time to display
in the plot.

C | Display a fixed time window during the instrument | Select Fixed View.
run

If the entire plot does not fit in the screen, the
screen is not updated as the run progresses. For
example, if you select 10 minutes from the View
dropdown menu, the plot will show data for 10
minutes. If the run lasts more than 10 minutes:

¢ The plot updates as the run progresses with
Fixed View deselected.

¢ The plot does not update as the run progresses
with Fixed View selected.

Temperature Plot Current Temperatures
S v
B iy g M cover A
.Sample

Temperature Plot
? Block

h

AR L]
LALLM AL

" Temperature Plot
o

Temperature

00:37:30 00:41:40 00:45:50 00:50:00 00:54:10 00:58:20 01 DQT;IDE 01:06:40 01:10:50 01:15:00 01:1:10 01:23:20 01:27:30 01:31:40 View 1 Hour v B
Fixed View [] C
The Temperature Plot screen can be useful for identifying hardware failures. When
monitoring the Temperature Plot screen, observe the Sample and Block plots for
abnormal behavior.
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* In general, the Sample and Block plots should mirror each other approximately. A
significant deviation of the plots may indicate a problem.

» The Cover plot should maintain the constant temperature specified in the method. A
departure from the constant temperature may indicate a problem.

If you notice an abnormal temperature plot, troubleshoot the error as explained in the
StepOne Software Help (click @ or press F1).

Note: The Sample temperature displayed in the Current Temperatures group is an
estimated value.

About the Run Method Screen

The Run Method screen displays the run method selected for the run in progress. The
software updates the Run Status field throughout the run. The figure below shows the
Run Method screen as it appears in the example experiment.

To... Action

A | Change the number of cycles In the Adjust # of Cycles field, enter the number of
cycles to apply to the Cycling Stage.

B | Add a melt curve stage to the Select Add Melt Curve Stage to End.
end of the run

C | Add a Hold stage to the end of Select Add Holding Stage to End.

the run
D | Apply your changes Click Send to Instrument.
— A
Pre-PCR Read (Holding Stage) Holding Stage Cyeling B
C
Starting Cycl D
100 —|
75 —|
50 —| T —
25 —|
o
Step 1 Step 1 Step 2 Step 1
< >
Legend
Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off ‘

If an alert appears, click the error for more information and troubleshoot the problem as
explained in the StepOne Software Help (click @ or press F1).

Notes
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Monitor the Run

Remote Monitor If your StepOne or StepOnePlus instrument is connected to a network, you can use the
Remote Monitor in the StepOne software to view the progress of the run in realtime from
any computer on the network.

IMPORTANT! Networked computers cannot control the StepOne or StepOnePlus
instrument, only monitor it.

To monitor your instrument remotely:

1. In the StepOne software, select Instrument » Remote Monitor.

2. In the navigation pane, select your instrument.

If the navigation pane does not list your instrument:
a. Click Add Instrument.

b. Enter a name for the instrument profile within the Remote Monitor.

Note: Enter any name that helps you identify the instrument. The profile name
you enter will be displayed in the Remote Monitor and in the instrument
dropdown menus when you send experiments, download experiments, or
monitor instruments.

c. In the Instrument Name, Host Name, or IP Address field:
 If you know the host name, enter the host name.

* If you do not know the host name, enter the instrument name or IP
address.

Note: The instrument name and IP address are displayed on the instrument
touchscreen. Go to Settings Menu » Admin Menu » Set Instrument Name or
Set IP Address. Contact your systems administrator or information technology
department for the host name.

d. Click Save & Exit.

Add Instrument

a Enter a name for this instrument profile within the Remote Monitor. Then, enter the instrument name, host name, or IP address to connect to the instrument. | Required
Ifyour network administrator provided you with a host name, enter the host name. Ifyou do not have a host name, enter the instrument name or IP address.  — a9 &

2b T " Profile Name
2c

*Instrument Name, Host Name, or IP Address

Save & Exit | \ Save & Add Another ‘ | Cancel

2d

Note: For more information on configuring the StepOne or StepOnePlus instrument
for network use or for the Remote Monitor feature, refer to the Applied Biosystems
StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking,
and Maintenance Guide.

Notes
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3. Click | %o | Start monitoring the instrument for your instrument. It may take
several minutes for the instrument to send the information to your computer.

1 !
File Edit Instrument Analysis Tools Help
[] NewExperiment - 5 open.. [ 5 Close I"_—I Send Experiment to Instrument. L_|r Download Experiment from Instrument... 49 Y
Manage Instruments <«
9 strument, then click "Monitor' to monitor the instrument: Local Simulator (Default) - @J
:
& Localn [ Run Status % Profile Mame:  Local Simulator ] Enable Run Nofifications
Estimated Time Remaining: 75 min 5 sec Status: Connected = ‘m
. ©J) | Notification Settings
2 # (Default) Local Simulator A Experiment Name: dieciipey  AlnEibiock ——
Experiment Type Serial Number:
37' L) =] {H L4 || & ‘ Temperature Plot
Temperature Plot Current Temperatures
110 W cover 25.0°C
- W sample 50.0°C
Block 50.0°C
g0
80
o 70
5
E 60
2
g =0
©
LT}
30
20
10
View Chart
0 , -
00:00:00 00:01:40 00:03:20 00:05:00 00:06:40 00:08:20 00:10; Wiew |10 Minutes  » |
Time Fixed View []

4. View data as described below.

# To... Action

A | View amplification data | Click Amplification Plot.

in realtime See “About the Amplification Plot Screen” on page 64.

B | View temperature data Click Temperature Plot.

for the run in reaitime See “About the Temperature Plot Screen” on page 65.

C | View progress of the Click Run Method.

run in the Run Method See “About the Run Method Screen” on page 66.
screen
D | Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “(Optional) Enable the Notification Settings” on page 57.

Notes
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Monitor the Run

File Edit Instrument Analysis Tools Help

[] New Experiment =[5 open.. [ £ Closs f.«i" Send Experiment to Instrument. L?l Download Experiment from Instrument... | £ B

Manage Instruments &

then click "Manitar to manitar the instrument. ARl ETGITEGIE (R ENTINS -

@ Local Instrument [ Run Status: 1% Profile Name:  Local Simulator [ Enable Run Notifications D
Estimated Time Remaining: 75 min & sec Status Connected | 8 (e |
. X fication Settings
¥ (Default) Local Simulator A Experiment Mame ;I;\ockl'l'lxlwcne.h 48-Well Block
Experiment Type: erial Number:
‘LJ |£J ‘LJ | L4 H % | Temperature Plot

Current Temperatures

/A\‘ ....... /B\ ..... /C\‘ .................................................... W cover 25.0°C
\—1—0/0/ = N W sample 50.0°C
Block 50.0°C

Standalone If you started the run from your StepOne or StepOnePlus instrument, you can view the
Monitoring progress of the run from the touchscreen. The Run Method screen displays the method
for the experiment and highlights the thermal profile steps as the instrument performs

them.
# To... Action
A | Add a melt curve stage | Touch i|-A. Add Melt Curve, then touch OK.
to the run
B | Display the time Touch Display Experiment Time, then touch X to return
remaining in the run to the Run Method screen.
C | Stoptherun Touch [ STOP, then touch:
¢ Stop to stop the run after the instrument completes the
current cycle or hold.
¢ Abort to stop the run immediately.
e X to continue the run with no changes.
D | View experiment Touch E View Experiment Information, then touch X to
information return to the Run Method screen.
E | View the Error Log Touch the status bar to display the error log.

Stage 2
( 50.0 °C 00:54:58

Experiment: Example_Experiment

Stage 3 Stage 4 Stage 5
X1 H 40 X1
a a
35.0"  95.0°
g 10:00 0:15 N o °
60..0 J 60..0 60..0
/7 0:30 2100 1:00 0:30
D ‘ B
Ao | 2 ) .} c
Ald Melt Curve View Experi Display Expetil 3TOP

Information Time

Notes
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Unload the Instrument and Transfer the Data

Unload the Instrument and Transfer the Data

When your StepOne or StepOnePlus instrument displays the Main Menu screen, unload
the reaction plate from the instrument and transfer the experiment data to the computer
for analysis.

Unload the ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Reaction Plate temperature of the sample block(s) can exceed 100 °C. Keep your hands away until the
sample block(s) reach room temperature.

Note: When the StepOne or StepOnePlus instrument completes a run, the system saves
the details of the run to the run history, which remains present in the system until the
instrument completes another run.

1. When the Run Report screen appears in the StepOne or StepOnePlus instrument
touchscreen, touch (#).

2. Open the instrument drawer.

3. Remove the reaction plate from the sample block(s).

4. Carefully close the instrument drawer.

A CAUTION

Select a Data Transfer the experiment to your computer for analysis according to the layout of your
Transfer Method  StepOne or StepOnePlus system:

Layout Description See...
Colocated The yellow cable connects the computer and “Colocated Data Transfer”
the instrument. below
Standalone The computer and the instrument are “Remote Data Transfer” on
(Networked) connected to the same network. page 71
Standalone The computer and the instrument are not “Standalone
(Basic) connected. Data Transfer” on page 72
Notes
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Unload the Instrument and Transfer the Data

Colocated If your computer is directly connected to your StepOne or StepOnePlus instrument by the
Data Transfer yellow cable, no action is necessary. The StepOne software automatically transfers the
experiment data from the instrument to the computer after the run.

Note: In a colocated layout, you can start the run from the computer or from the
instrument touchscreen. However, the StepOne software only transfers the experiment
data automatically when a run is started from the computer (see “Colocated Startup” on
page 59).

Remote If your computer and StepOne or StepOnePlus instrument are connected to the same
Data Transfer Ethernet network, download the experiment from the instrument over the network:

1. In the StepOne software, click %, Download Experiment from Instrument to
open the Download Experiment from Instrument dialog box.

2. From the Select Instrument dropdown menu, select your instrument.
3. From the Experiment dropdown menu, select the example experiment file.

4. In the Download File To field:
a. Click Browse.

b. Navigate to:
<drive>:\Applied Biosystems\<software name>\experiments\
where:

<drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

<software name> is the current version of the StepOne software.

c. Click Select.

5. Click Download Experiment to download the example experiment file from your
instrument to your computer over the network.

Download Experiment from Instrument

n Selectthe instrument with the sxperiment, select a location on this computsr for the experiment, )
then click "Download Experiment.” i

2 I « 1. 8elect Instrument: % Local Instrument (Default)y | Experiment 3
4 | - 2 Download File To; | CMpplied Biosystems\StepOne Software v2.0lexperiments | Browse...
5 | | Cancel ‘

6. When prompted, click OK to close the confirmation.

Download Complete

Notes
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Unload the Instrument and Transfer the Data

Standalone If your computer is not connected to your StepOne or StepOnePlus instrument, use the
Data Transfer USB drive to transfer the experiment from the instrument to the computer:

1. If not already connected to the instrument, connect a USB drive to the USB port.

I

2. Touch the StepOne or StepOnePlus instrument touchscreen to awaken it.

Note: If the touchscreen is not at the Main Menu screen, touch @

3. Wait for the USB sign to appear on the touchscreen.

4. Inthe Main Menu, touch Collect Results to save the data to the USB drive.
Note: If your instrument cannot find the USB drive, remove the USB drive, then try

again. If the instrument still does not recognize the USB drive, try another USB
drive.

5. When prompted that the data has been transferred successfully, touch OK.
i‘;;)\?riem]el\;i:' | Settings Menul Tools Menu | Ig:sltzl‘é: |

& Information
RiaseP Wi RESTISLY

Experiment results reacy:
You may remave your USE storage

Shorteu Shorteut
5 oK I 8
@ 2006-11-18 | 2:15 PM ‘»
<

6. Remove the USB drive from your instrument, then connect it to one of the USB
ports on your computer.

7. In the computer desktop, use the Windows explorer open the USB drive.

Notes
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Unload the Instrument and Transfer the Data

8. Copy the example experiment file to:
<drive>:\Applied Biosystems\<software name>\experiments\

where:

» <drive> is the computer hard drive on which the StepOne software is installed.
The default installation drive for the software is the D drive.

» <software name> is the current version of the StepOne software.

Notes
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Unload the Instrument and Transfer the Data

Notes
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E Analyze the Experiment

This chapter covers:

B Chapter OVeIrVIEW . . . oottt e e e e e e 76
B Section5.1 Review Results............ ... .. ... ... . . 77
B Section 5.2 Troubleshoot (If Needed). . ........... .. ... ... ... .......... 97

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne'™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Chapter Overview

Chapter Overview

The StepOne"™ software analyzes your data using the endpoint method. Section 1 of this
chapter explains how to review the analyzed data using several of the analysis screens
and how to publish data. If you receive questionable results, Section 2 of this chapter
explains how to perform some troubleshooting steps.

Example The workflow for analyzing the example experiment provided with this getting started
Experiment guide is shown below.
Workflow

Start Experiment
v
Design the Experiment (Chapter 2)
v
Prepare the Reactions (Chapter 3)

h 4
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

Section 1, Review Results:

Analyze the experiment.

View the presence/absence plot.
View the amplification plot.

View the results in a table.
Publish the Data.

Section 2, Troubleshoot (If Needed):
1. View the analysis settings.

o Dd -~

View the quality summary.
Omit wells.

View the multicomponent plot.

o~ DN

View the raw data plot.

v

End Experiment

Notes
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Section 5.1 Review Results

Section 5.1 Review Results

This section covers:

B Analyze the EXperiment . .. ...ttt 78
B View the Presence/Absence Plot. . ........ ... ... .. ... ... ... ... .. ... .... 84
B View the Amplification Plot. .. ....... ... ... ... . ... .. ... .. .. . ... 86
B Viewthe Well Table .. ....... .. ... . i 93
B Publishthe Data ........ ... ... . . . 96
Notes
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Analyze the Experiment

Analyze the Experiment

Notes

78

About the
Example
Experiment

Analyze the
Example
Experiment

The StepOne software analyzes the experiment and displays results in the analysis
screens (for example, the Amplification Plot screen or the QC Summary screen).

For the presence/absence experiment, use the data file that installs with the StepOne
software. The data file was created with the same design parameters provided in
Chapter 2, then run and analyzed on a StepOne system.

You can find the data file for the example experiment on your computer:

<drive>:\Applied Biosystems\<software name>\experiments\examples\
Presence Absence Example.eds
where:

* <drive> is the computer hard drive on which the StepOne software is installed. The
default installation drive for the software is the D drive.

* <software name> is the current version of the StepOne software.

—

Double-click g- (StepOne software shortcut) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
2. From the Home screen, click Open.

3. In the Open dialog box, double-click the examples folder:
<drive>:\Applied Biosystems\<software name>\experiments\examples

4. Double-click Presence/Absence Example to open the example experiment data
file.

Note: The examples folder contains several data files; be sure to select Presence
Absence Example. For information on the other data files, see “Data Files in the
Examples Folder” on page 12.
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Analyze the Experiment

2 e Eperme— B Open.. [ B JJ Send Experiment to Instrument... Lf, Download Experiment from Instrument...  £9 8

Analyze

ﬁ‘ e Experiment

3 i ) examples v [ IEEE

i] 96-Well Genotyping Example.eds
i] 96-Well Multiplex Example.eds
My Recent 1) 96-Well Presence Absence Example eds
_ Documents | |4) 96-Well RNaseP Experiment eds
|#] 96-Well Standard Curve Example.eds
3] 96-Well SYER Example eds
i] Comparative CT Example.eds
i] Genotyping Example.eds
i] Multiplex Example.eds
4 i] Presence Absence Example.eds
WMy Documents i] Relative Standard Curve Example.eds
R i] RNase P Experiment eds

- i] Standard Curve Example eds
CL

i] SYBR Example.eds

My Computer

“
File name

My Network
Places Files oftype: Al SDS Files (edm; eds; edt)

5. In the Experiment Menu pane, click Analyze. The StepOne software analyzes the
data using the default analysis settings.

File Edit Instrument Analysis Tools Help

[&] Mew Experiment - [5 Open... = save - =} Close TJ_“ Send Experiment to Instrument.. L_|r Download Experiment from Instrument..  &# Export. = 54 Print Fleport..

Experiment Menu <« ] Fxperim _ Presence Absence Fxamp Ty _ Presence/Absenct Reage = TagMan® Reagents @;
' Setup Presence/Absence Plot <[ View Plate Layout | View Well Table |
Im Run | (" Plot Settings SelectWells With: |- Select ltem - ||

See “Software Elements” below and “Navigation Tips” on page 82 for information on
navigating within the analysis screens.

Guidelines When you analyze your own presence/absence experiment immediately after a run, the
StepOne software automatically analyzes the data using the default analysis settings, then
displays the Presence/Absence Plot on your computer. To reanalyze the data, click
Analyze.

Notes
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Analyze the Experiment

Software The StepOne software elements for the analysis screens are illustrated below.

Elements _ ) _
1. Menu bar — Displays the menus available in the software:

* File

* Edit

* Instrument
* Analysis
* Tools

* Help

2. Toolbar — Displays the tools available in the software:
* New Experiment
* Open
» Save
* Close
* Send Experiment to Instrument
» Download Experiment from Instrument
* Export
» Print Report

3. Experiment header - Displays the experiment name, experiment type, and reagents
for the open experiment.

4. Experiment Menu pane — Provides links to the following software screens:
* Setup screens
* Run screens
* Analysis screens:
—Presence/Absence Plot
—Amplification Plot (if the experiment includes amplification)
—Multicomponent Plot
—Raw Data Plot
—QC Summary
—Multiple Plots View

5. Plot pane — Displays the selected analysis screen for the open experiment.
6. View tabs — Displays the Plate Layout or Well Table for the open experiment.

7. Experiment tab(s) — Displays a tab for each open experiment.

Notes
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—

File Edit Instrument

Analysis

Tools  Help

2 [i] New Experiment = [25 Open

[ save - 5 Clos

Plot Settings

E) Jl_‘l Send Experiment to Instrument.

Target Rep:
Control Rep!

ofer Pathogen v

Show IPC []
Show Controls [

Show Calls )| calls v

[N =
4 Amplification Plot
Presence/Absence Results
Multicomponent Plot i, *+“+++++*+++*+
[E= Raw Data Plot 22
&
QC Summary @ ‘7
=
12
ultiple Plots View
07
Taegdt Threshald
7 7 7 a7 E
Wiiell Posttion
Legend
Unknown Calls: @ Presence = Absence 2 Unconfirmed
IPC Calls: = IPC Failed B |PC Succeeded
Controls: w Negative Control = Blocked IPC Contral

Download Experiment from Instrument.

5B Export.. - Print Report

Analysis Seftings

>

Select Wells With: |- Select tam - | | |

| Elslmwmwmls' View Legend |
1 2 3 4 i B T a8

Awc [Awrc [Arc [Awrc  @Eliec lrc i lec | lirc

A | & patn..,. [ pate.... [T patn. . [ Path. ;[ Patn... [ Patn. .. [ Path.... [] Path..|
e @l @lrc (Wl @liec lec e [l e

5 | ran... [T Patn... [ Patn..\ [ Path.. [ Fatn.. | [ Path... [ Patn... [0 Path..
e @l @lrc (Wl @liec lec e [l e

C | ran... [T Patn... [ Patn.\ [ Path.. [ Fatn.. | [T Path... [ Patn... [0 Path..
e @l @lrc (Wl @liec lec e [l e

O | ran... [T Patn... [ Patn.\ [ Path.. [0 Fatn.. . [T Path... [ Patn... [0 Path..
e @l @lrc (Wl @liec lec e [l e

E | ran... [T Patn.. [0 Patn.\ [ Path.. [ Fatn.. | [T Path.... [ Patn... [0 Path..
e @l @lrc (Wl @liec lec e [l e

F | patn.. [ Patn... [T Path... [T Patn... [0 Path.. [ Path..: O] Path.... [ Path..

Wells: 0 Unknown 0 NC | 40 Unknown-IPC 4 NC-IPC 4 NC-Blocked IPC 0 Emp|

& Analysis Summary:

Total Wells in Plate: 4§ Wells SetUp: 48 Wells Omitted Manually: 0

‘Wells Flagged: 0

Wells Omitted by Analysis: 0

Samples Used: 5

Targets Used: 2

7 Presence Absence Example.eds)

Notes
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Navigation Tips How to Select Wells

Notes

82

To display specific wells in the analysis screens, select the wells in the View Plate Layout
tab as follows:

1. To select wells of a specific type, use the Select Wells With dropdown menus: Select
Sample, Target, or Task, then select the sample, target, or task name.

2. To select one well, click the well in the plate layout.

3. To select multiple wells, click and drag over the desired wells, press CTRL+click,
or press Shift+click in the plate layout.

4. To select all 48 wells, click the top left corner of the plate layout.

4 1

View Plate LayoutT View Well Table }

SelectWells With: |- Select Item - v||

| |E| Show in | Valls ¥ | T view Legend | | |
1 2 3 4 5 [ 7 8
IPC IPC IPc IPC IPC IPc IPC IPC
A [ Pathagen [ Pathagen [ Pathogen [ Pathagen [ Pathagen [ Pathogen [ Pathagen [ Pathagen
|PC |PC E\PC |PC |PC E\PC |PC |PC

B mPathogen 8 mPathagen e m Pathogen & mPathogen 8 mPathagen e m Pathogen & mPathogen 8 mPathagen e

i rc I e I e T I e I e T I e
c m Pathogen 8 m Pathogen e m Pathogen & m Pathogen 8 m Pathogen e m Pathogen & m Pathogen 8 m Pathogen e

i rc I e i e i ec I e i e i ec I e
D [ Pathogen = [i] Pathogen e [O Pathogen e [i] Pathogen = [i] Pathogen e [O Pathogen e [i] Pathogen = [i] Pathogen -

il e T [ IPc T 4 T [ IPc T 4 T [

ElM ratrogen  ® [ ratrogen @ ‘[ ratnogen @ [ ratrogen @ /[ ratrogen @ ‘[ ratnogen @ /[ ratrogen @ Al rathogen @

IPC IPC E\Pc IPC IPC E\Pc IPC IPC

F mPathogen @ mPathagen @ m Pathogen @ mPathogen @ mPathagen @ m Pathogen @ mPathogen @ mPathagen @

Wells: 0 Unknown 0 NC | 40 Unknown-IPC 4 NC-IPC 4 NC-Blocked IPC 0 Empty
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How To Display Multiple Plots

Chapter 5 Analyze the Experiment E

Analyze the Experiment

Use the Multiple Plots view to display up to four plots simultaneously. To navigate within

the Multiple Plots view:

1. From the Experiment Menu pane, select Analysis » e

To display four plots, click =2

Show plots in a 2 X 2 matrix.

To display two plots in columns, click [|| Show plots in two columns.

2.
3. To display two plots in rows, click = Show plots in two rows.
4.
5.

Multiple Plots View.

To display a specific plot, select the plot from the dropdown menu above each plot

‘Presencemhsence Results A |

=2

by &2
Presence/Absence Results

[nmpimication Piot - ARnvs Cycle v

P poa ks

Amplification Plot

W e : -~
z | g —
g 20 i I i e Bt T “J
E ol e R s e e |

TargiFeshild S R
00 = Legend
7 7 27 a 47 ’V A cllcilcI: - ‘
Well Position

Multicomponent Plot v |Raw Data Plot v ‘

a =

Legend

-

ellcilclN: -

Al e N c o N:

’— Legend

Notes
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View the Presence/Absence Plot

The Presence/Absence plot displays the intensity of the fluorescence for each well
position. There are four Presence/Absence plot views available:

« All Calls

* Presence calls only
» Absence calls only
* Unconfirmed calls

For each view, you can choose to:
¢ Show IPC
¢ Show Controls

About the In the presence/absence experiment:
Exqmple * The target is absent in samples Unknown 1, Unknown 2, and Unknown 3.
Experiment * The target is present in samples Unknown 4 and Unknown 5.
* There are no unconfirmed wells.

¢ The IPC succeeded in all wells.

View the 1. From the Experiment Menu pane, select Analysis » Presence/Absence Plot.

Presence/
Absence Plot Note: If no data are displayed, click Analyze.

2. For an expanded display of the 48 wells of the Presence/Absence screen, click the
upper left corner of the plate layout in the View Plate Layout tab.
From the Target Reporter dropdown menu, select Pathogen.

From the Control Reporter dropdown menu, select IPC.

From the Show Calls dropdown menu, select All Calls.

o o >

Click the = Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

7. Click the Show IPC checkbox to view the fluorescence intensity of the IPC target in
the Unknown-IPC wells.

8. Click the Show Controls checkbox to view the fluorescence intensity of the IPC
target in the Negative Control-IPC wells and the Negative Control-Blocked IPC
wells.

9. To view the fluorescence intensity of only the presence calls, select Presence from
the Show Calls dropdown menu.

Notes
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View the Presence/Absence Plot

10. To view the fluorescence intensity of only the absence calls, select Absence from
the Show Calls dropdown menu.

11. To view the fluorescence intensity of only the unconfirmed calls, select
Unconfirmed from the dropdown menu.

Note: The Presence/Absence example experiment does not contain any
unconfirmed calls.

PresenceAbsence Flt I—I—TI
Plot Setti —
|
Target Reportsr [pathogen i ShowIPC []
Control Reporter ||pg v Show Controls [] —
Show Calls [a cans v—

=y

Presence/Absence Results

Intensity

Tapged Threshold

Wiell Pasition

Legend
Unknown Calls: @ Prasence = Absence * Unconfirmed
IPC Calls = IPC Failed B |PC Succeeded
Controls: ® [egative Control = Blocked IPC Control

Analysis When you analyze your own experiment, review the presence/absence plot for:
Guidelines e The IPC threshold — this value is calculated from the Negative Control- Blocked
IPC reactions.
* The Target Threshold — this value is calculated from the Negative Control- IPC

reactions. If the target’s intensity is:

— Above the target threshold, the call is present (regardless of the intensity of the
IPC).

— Below the target threshold, and the IPC’s intensity is above the IPC threshold, the
call is absent.

— Below the target threshold, and the IPC’s intensity is below the IPC threshold, the
call is unconfirmed.

Notes
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» Target Calls:
— Presence
— Absence
— Unconfirmed
* IPC Calls:
— IPC Succeeded
— IPC Failed
* Control Well Calls:
— Negative Control - [PC

Negative Control - Blocked IPC

For More For more information on the Presence/Absence Plot screen, access the StepOne Software
Information Help by clicking @ or pressing F1.

View the Amplification Plot

The amplification plot displays amplification of all samples in the selected wells. There
are three amplification plot views available:

* ARn vs Cycle — ARn is the difference in normalized fluorescence signal generated
by the reporter between the pre-PCR read and the post-PCR read. This plot displays
ARn as a function of cycle number. You can use this plot to identify and examine
irregular amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence signal from the reporter dye normalized to the
fluorescence signal from the passive reference. This plot displays Rn as a function
of cycle number. You can use this plot to identify and examine irregular
amplification.

* Cpvs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays C as a function of well
position. You can use this plot to locate outlying amplification (outliers).

IMPORTANT! Amplification plots are not used to make presence/absence calls. Examine
the plots to help with troubleshooting and quality control.

About the In the presence/absence example experiment, you review the amplification plot for:
Example » Correct baseline and threshold values

Experiment o
perime * Irregular amplification
e Outliers
Notes
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View the Amplification Plot

View the 1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Amplification
Plots Note: If no data are displayed, click Analyze.
2. Display all 48 wells in the amplification plot by clicking the upper left corner of the
plate layout in the View Plate Layout tab.
3. Expand the View Plate Layout tab by clicking the left facing arrow that is left of the
tab.
32
Amplification Plot <[ Viiew Piate Layout | View Wal Table |
—
Plot S tings \ > Selectwelis with: |- Select tem - v || |
Plot Type: ARnvs Cycle || Graph Type:|L| v | PlotColor|well v
‘ e | | = | | < ‘ ‘ | EShnwinWellsv ViewLegend ‘ |
P LEAREE
: : 1 2 El 4 a 3] 7 8
Ampllﬁcatlon PIOt IPC IPC IPC IPC IPC IPC n IPC IPC
2;2 A D Path D Path. D Path D Path D Path. D Path D Path D Path.
ZE: e [lerc Elec (EHiec (liec e Elec e
175 A= ® path.... [ Path Path.... [ Path... [ Path Path.... [ Path.... [ Path
£ 150
4
= :'g: [ T N T N [ T N T N [T N
075 © path.... [ Path path.... [ Path... [I] Path path.... [ Path... [I] Path
050
025 HWerc [lerc (Hlrec (EHiec (liec e Elec e
ooo b Path Path Path. Path Path Path. Path Path
F 4 L] & 1012 14 16 18 20 2 ¥ M ¥/ N @ M ¥ M 4
Legend cre e [lerc Elec (EHiec (liec e Elec e
" eg:n s c o EE: - ‘ E path.... [ Path Path.... [ Path... [ Path Path.... [ Path... [ Path
Options re [lec e [ T N T N [T N
Target Threshold l:l F path.... [ Path path... [ Path.... [ Patn path... [ Path.... [ Patn
Show: [] Threshold — [[] Baseline Start Well B Target . Baseline End: Well (B
‘Wells: 0 Unknown 0 NC | 40 Unknown-IPC 4 NC-IPC 4 NC-Blocked IPC 0 Emp|

4. In the Amplification Plot screen:
a. From the Plot Type dropdown menu, select ARn vs Cycle.
b. From the Plot Color dropdown menu, select Well.

c. Click the £= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

5. View the baseline values:
a. From the Graph Type dropdown menu, select Linear.
b. Select the Baseline checkbox to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescent signal is detected.
In the example experiment, the baseline is set correctly.

Notes
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6. View the threshold values:
a. From the Graph Type dropdown menu, select Log.
b. Select the Threshold checkbox to show the threshold.

c. Verify that the threshold is set correctly.

6a

Plot
Plot Type:|ARnvs Cycle % | Graph Type:|Log v—‘ Plot Color:Well e ‘

Amplification Plot
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| S =
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0.0000001 +
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[ Legend
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Options
Target Al v|Threshold: [Jauto [ ] [AuioBassline

show: [v] Fhreshold — [7] Baseline Start Well B Target 4 Baseline End: Well (B Target 4.
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View the Amplification Plot

7. Locate any outliers:
a. From the Plot Type dropdown menu, select Cy vs Well.

b. Look for outliers from the amplification plot.

7a
Plot Setti
|
Plot Type:[CTvs Well | Graph Type:| | PlotColorjwell v ‘
AP a kK=
Amplification Plot
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Legend
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Analysis When you analyze your own presence/absence experiment, look for:
Guidelines . Qutliers

* A typical amplification plot — The StepOne software calculates baseline and
threshold values based on the assumption that the data exhibit a typical
amplification curve. A typical amplification plot has four distinct sections:

a. Plateau phase
b. Linear phase
c. Exponential (geometric phase)

d. Baseline

Notes
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IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the StepOne software. Therefore, Applied
Biosystems recommends that you examine the Amplification Plot and review the
assigned baseline and threshold values for each well after analysis completes.

» Correct baseline and threshold values — See the threshold examples on page 91 and
the baseline examples on page 92.

Notes
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View the Amplification Plot

Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum
increase the standard deviation of the replicate
groups.

Threshold Set Too Low

The threshold is set below the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar up
into the exponential phase of the curve.

Threshold Set Too High

The threshold is set above the exponential phase of
the amplification curve. The standard deviation is
significantly higher than that for a plot where the
threshold is set correctly. Drag the threshold bar
down into the exponential phase of the curve.

0.242796.

1\
0.0001 et

F L \/
0.0001 L

L.754743

\
| \
0.0001 .

Notes
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View the Amplification Plot

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right
of the maximum baseline. Increase the End Cycle .
value. 5§,

Baseline Set Too High

The amplification curve begins before the
maximum baseline. Decrease the End Cycle value. '

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 98).
or
e Omit wells, (see “Omit Wells from the Analysis” on page 102).

For More For more information on the Amplification Plot screen, access the StepOne Software
Information Help by clicking @ or pressing F1.

Notes
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View the Well Table

View the Well Table

The Well Table displays results data for each well in the reaction plate, including:

* The well number, sample name, target name, task, and dyes
e The calculated values: ARn, ARn mean, and ARn SD

Note: ARn, ARn mean, and ARn SD are calculated only when the analysis call
settings specify to analyze data from the pre-PCR read and the post-PCR read.

» Target and IPC thresholds, Call, Comments
* Flags

About the In the presence/absence example experiment, you review the Well Table for:
Example .
Experiment . ARn

* Flag

View the Well 1. From the Experiment Menu pane, select Analysis, then select the View Well Table
Table tab.

Note: If no data are displayed, click Analyze.

2. Use the Group By dropdown menu to group wells by a specific category. For the
example experiment, group the wells by flag, call, and ARn value.

Note: You can select only one category at a time.

a. From the Group By dropdown menu, select Flag:
* None of the wells are listed under Flagged.
» All the wells are listed under Unflagged.

Notes
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View the Well Table

2a
|

View Piafe Layout | View Well Table |

Select Wells With: |- Select ltem - Selecitam- v

#  Well
B8 U;

[ omn | Fiag | samplena.. Name | Task | Dyes 8RN ORnMean ARNSD  Threshol. Call Comme.. | ©

d Wells

b. From the Group By dropdown menu, select Call. Wells are listed in the order:

Absence

Blocked IPC Control
IPC Succeeded
Negative Control
Presence
Unconfirmed

IPC Failed

94
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View the Well Table

View Piate Layout | View Well Table |
I i+ =
# Wel | Omt  Flag | S Na.. | Name | Task &R0 ARnMean ARnSD  Threshol. Call Comme... | €

= Blocked IPC Control

= IPC Succeeded

c. From the Group By dropdown menu, select None. In the table, click the
column heading ARn. Wells are listed in order of increasing ARn. Click the
column heading again to reverse the sort order.

View Piafe Layout | View Well Table |

Select Wells With: |- Select ltem - Selecitam- v

# Wel | Omt Flag S Na.. | Name | Task AR ' ARnMean ARNSD  Threshol.. Call Comme.. | €
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Publish the Data

Analysis When you analyze your own presence/absence experiment, group the wells by:

Guidelines * Flag —The software groups the flagged and unflagged wells. A flag indicates that the
software has found an error in the flagged well. For a description of the StepOne
software flags, see “View the QC Summary” on page 100.

» Call — The software groups the wells by call: Negative Control, Blocked-IPC,
Presence, Absence, Unconfirmed, IPC Succeeded, and IPC Failed.

For More For more information on the Well Table, access the StepOne Software Help by
Information clicking @ or pressing F1.

Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
* Export data

Fore More For information on performing these procedures, access the StepOne Software Help by
Information clicking @ or pressing F1.

Notes
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Section 5.2 Troubleshoot (If Needed)

Section 5.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . .. .. ..ot 98
B View the QC SUMMATIY . . . ..ot v ettt et e e e e ettt 100
B Omit Wells from the Analysis. . ........ ... ... i 102
B View the Multicomponent Plot. .. ........ ... ... ... ... ... ... ..., 103
M Viewthe Raw DataPlot ... ........ ... . .. .. .. ... .. . . . . . . .. 105
Notes
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View the Analysis Settings

View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the call settings,
threshold cycle (Cy), and flags. If the default analysis settings in the StepOne software,
are not suitable for your experiment, you can change the settings in the Analysis Settings

About the
Example
Experiment

Review the
Analysis Settings

Notes

98

dialog box, then reanalyze your experiment.

In the presence/absence example experiment, the default analysis settings are used

without changes.

1. From the Experiment Menu pane, select Analysis.

2. Click Analysis Settings to open the Analysis Settings dialog box.

In the example experiment, the default analysis settings are used for each tab:

* Call Settings
* Cj Settings
* Flag Settings

4. Analysis Settings for Presence Absence Example

|.Call Settings | Ct Seftings I Flag Settings I Advanced Settings l

settings that are displayed.

Data Analysis Settings

Default Call Settings

"Edit Default Settings.”

Confidence Valus: 99% | Edit Defaut Settings

Select a Target

Target Analysis Type Confidence
Pathogen Default 99%
IFC Default 59%

a Review the default settings for analysis of targets in this experiment. To editthe default settings, click "Edit Default Settings.” To
use different settings for a target, selectthe target from the table, deselect the "Use Default Setlings” checkbox, then change the

(O Analyze Data from Post-PCR Read Only (2 Analyze Data from Pre-PCR Read and PostPCR Read

Default call settings are used to make presence/abssnce calls for targets without customn settings. To editthe default ssttings, click

Call Settings for Pathogen
Call Settings to Use Use Default Settings

o]

Revert to Original Analysis Seftings

Apply Analysis Settings

Cancel
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View the Analysis Settings

Analysis  Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the StepOne software. If the default settings are not suitable
for your experiment, you can change the:

* Call Settings — Use this tab to specify whether to analyze data from the pre-PCR
read or to edit the default confidence value used to make presence/absence calls for
each target.

* C; Settings (if the experiment includes amplification) — Use this tab to set the
threshold and baseline either automatically or manually. When you manually set the
threshold and baseline, keep the following Applied Biosystems recommendations in

mind:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
e Within the exponential phase of the amplification curve.
Baseline Select Start Cycle and End Cycle values so that the baseline ends

before significant fluorescent signal is detected.

» Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

For More For more information on the analysis settings, access the StepOne Software Help by
Information clicking @ or pressing F1 when the Analysis Settings dialog box is open.

Notes
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View the QC Summary

Notes

100

About the
Example
Experiment

View the QC
Summary

The QC Summary displays a list of the StepOne software flags. This summary includes
the flag frequency and location for the open experiment.

In the presence/absence example experiment, you review the QC Summary for any flags
triggered by the experiment data. In the example experiment, no flags have been
triggered.

1. From the Experiment Menu pane, select Analysis » QC Summary.

Note: If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, there are 0 flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment. In the example experiment, the Frequency
column displays O for all the flags.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the experiment.

4. (Optional) Click each flag row to display detailed information about the flag.

QC Summary
Flag v
Total Wells: 48 | Processed Wells. 48 | Targets Used 2
Wells Set Lip 48 | Flagged Wells p Samples Used &
‘ 2
Flag Details
Flag: Mame Frequency Wells

EBADROX

Bad passive reference signal

MOSIGNAL

o signal in well

OFFSCALE

Fluorescence is offscale

AMPNG

EEEE

Amplification in negative control

MNOISE

Noise higher than others in plate

SPIKE

Noise spikes

EXPFAIL

Exponential algorithm failed

BLFAIL

Baseling algorithm failsd

THOLDFAIL

IBEEEE

Thresholding algorithm failed

Flag: BADROX—Bad passive reference signal
Flag Detail: Passive reference signal is abnormal
Flag Criteria: Fluorescence < 500.0
Flagged Wells: None

View BADROX Troubleshooting
Information
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View the QC Summary

Possible Flags For presence/absence experiments, the flags listed below may be triggered by the
experiment data.

Note: If the experiment does not include amplification, then the only flags are
BADROX, NOSIGNAL, and OFFSCALE.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells column.

Flag Description

AMPNC Amplification in negative control
BADROX Bad passive reference signal
BLFAIL Baseline algorithm failed
CTFAIL | Cy algorithm failed

EXPFAIL | Exponential algorithm failed
NOAMP | No amplification

NOISE Noise higher than others in plate
NOSIGNAL No signal in well

OFFSCALE Fluorescence is offscale

SPIKE | Noise spikes

THOLDFAIL | Thresholding algorithm failed

Analysis When you analyze your own presence/absence experiment:

Guidelines * Click each flag in the Flag Details table with a frequency >0 to display detailed
information about the flag. If needed, click the troubleshooting link to view
information on correcting the flag.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the StepOne software.

For More For more information on the QC Summary screen or on flag settings, access the StepOne
Information Software Help by clicking @ or pressing F1.

Notes
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Omit Wells from the Analysis

You may omit wells from analysis if you do not want to consider data generated by the
well.

About the In the presence/absence example experiment, there are no outliers; no wells need to be
Example removed from analysis.
Experiment

Omit Wells 1. Click the View Plate Layout tab.
2. Select one or more wells to omit from analysis.

3. Right-click the well(s), then select Omit. Results for the well are removed.

View Plate LayoutT View well Table ]

SelectWells With |- Select tem - v ||

[3 | showinwells ¥ | View Legend ‘ |
1 | 2 | 3 | ' | § | 8 | 7 | 8 |
Pc IPC IPC Pc IPC IPC e IPC
" [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen [ Pathogen
IPc IPC IPC IPc IPC IPC IPc IPC
B Pathogen = Pathogen E Pathogen = Pathogen = Pathogen E Pathogen = Pathogen = Pathogen E
E\PC |PC |PC E\PC |PC |PC E\PC |PC
c Pathogs] C. = 8 Pathogen e Pathogen & Pathogen 8 Pathogen e Pathogen & Pathogen 8
opY
e Zoom In IPC e IPC IPC e IPC
P | [ patnosd CATu(eIS = Pathogen = Pathogen @ Pathogen = Pathogen = Pathogen @ Pathogen =
Fit Plate
P Full Sereen IPC IPC IPC IFC P IPC
E Pathoga| Omit | ® Pathogen @ Pathogen ® Pathogen ® Pathogen @ Pathogen ® Pathogen ®
Include
E\PC Save As... |PC E\PC |PC |PC E\PC |PC
F Pathoge| Ptl’i @ Pathogen @ |[[ rathogen (] Pathogen @ Pathogen @ Pathogen @ Pathogen @
TNt Preview. ..
— Print. .
Wells: 0 Unknowrm o ™G | 0 Unkmown-IPC 4 NC-IPC 4 NC-Blocked IPC 0 Empty

4. Click Analyze to reanalyze the data without the omitted wells.

Analysis When you analyze your own presence/absence experiment, carefully consider which
Guidelines  wells to omit from analysis. If needed, remove outliers manually using the Well Table.

1. From the Experiment Menu pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Amplification Plot screen, select Cy vs Well from the Plot Type dropdown
menu.

3. Select the View Well Table tab.

Notes
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View the Multicomponent Plot

4. Review the Well Table:
a. Look for any outliers.

b. Select the Omit checkbox next to the outlying well(s).

5. Click Analyze to reanalyze the experiment data with the outlying well(s) removed
from the analysis.

For More For more information on omitting wells from the analysis, access the StepOne Software
Information Help by clicking @ or pressing F1. Within the Help, search for the omit well topics:

1. Click the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of a PCR run.

About the In the presence/absence example experiment, you review the Multicomponent Plot for:
Example . Rrox™ dye
Experiment . VIC® dye
+ FAM™ dye
» Spikes, dips, and/or sudden changes.
* Amplification in the negative control wells.

View the 1. From the Experiment Menu pane, select Analysis »

Multicomponent
Plot Note: If no data are displayed, click Analyze.

Multicomponent Plot.

2. Display the wells one at a time in the Multicomponent Plot screen:
a. Click the View Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: Ifyou select multiple wells, the Multicomponent Plot screen displays the
data for all selected wells simultaneously.

3. From the Plot Color dropdown menu, select Dye.

Notes
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View the Multicomponent Plot

4. Click the E Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. Check the ROX dye signal. In the example experiment, the ROX dye signal remains
constant throughout the run.

6. Check the VIC dye signal. In the example experiment the VIC dye signal should not
amplify for NC-Blocked IPC wells or if the IPC call for the Unknown-IPC well is
IPC Failed.

7. Check the FAM dye signal. In the example experiment, the FAM dye should amplify
for Unknown-IPC wells that receive a target call of Presence.

3 4 2a 2b
Multicomponent Plot _-< View Plate Liyout T View well Table ]
Plot Setth ’ Sel{ctwelis with: |- select tem - || |
Flot Color |Dye 4 ] - -
| @ snowinwells v | [FE view Legznd ‘ |
a0 ==
1 [ 3z ] 4 [ s [ e [ 7 ] &8 |
Mutticomponent Plot
13,000 . Hire [HAvc |[[Awc |[Hwrc [Hwec [Elec [lirc [l irc
12000 [ Path... [ Flath...| [ Path... [ path.. (2] Path... [ Path... [ Path... [ Path...
11,000
10,000 Herc [lerc |lwrec [EHiec Wliec Elwrc Elrec Eliec
8,000 E Path. Path m Path. Path Path m Path. Path Path
» B.000 .
8 ; . - - . .
g 7.000 i - Eerc Elerc [lrec [EHiec [Wliec [Eliec Eliec Eliec
£ so0 path... [ Path... [ Patn...| [ Path... [0 Path... [T Path... [ Patn... [I] Path
2 5000 Ry -
4.000 o ¥ IPc IPC IPC IPc IPC IPC IPc IPC
5 Z-EEE N 7_7(_"':_7_7_7_7_7_ B path... [ Patn... [T Patn... [ Path... [ Path..| [ Path... [0 Path... [0 Patn
6 R E\Pc IPC IPC E\Pc IPC IPC E\Pc IPC
7 E Path Path m Path. Path Path m Path. Path Path
1.0 0 2 4 & 8 W 12 14 W 18 A W ¥ X W N W M OB B oW oL oM —
Cycle Eerc Elerc [lrec [EHiec [Wliec [Eliec Eliec Eliec
Legend F path... [ Path... [ Patn...| [ Path... [0 Path... [T Path... [ Patn... [I] Path
B rox I vic I Fan ||
‘Wells: 0 Unknown 0 NC | 40 Unknown-IPC 4 NC-IPC 4 NC-Blocked IPC 0 Emp|

Analysis When you analyze your own presence/absence experiment, look for:

Guidelines » Passive reference (ROX)- The passive reference dye fluorescence level should

remain relatively constant throughout the PCR process.

* Reporter dye (FAM) — The reporter dye fluorescence level should display a flat
region corresponding to the baseline. If target is present in the sample (a Presence
call is made), the baseline will be followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or
sudden changes in the fluorescent signal.

* Negative control wells — There should not be any amplification in the negative
control wells.

Notes
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View the Raw Data Plot

For More For more information on the Multicomponent Plot screen, access the StepOne Software
Information Help by clicking @ or pressing F1.

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence signal (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

About the In the presence/absence example experiment, you review the Raw Data Plot screen for a
Example stable increase in signal (no abrupt changes or dips) from the appropriate filter.
Experiment

View the Raw 1. From the Experiment Menu pane, select Analysis » Raw Data Plot.

Data Plot
Note: If no data are displayed, click Analyze.

2. Click the £= Show a legend for the plot (default).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate.

3. Display all 48 wells in the Raw Data Plot screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

4. Select wells corresponding to a replicate group:

* Unknown 1 wells: From the Select Wells with dropdown menus, select Sample
and Unknown 1.

* Unknown 2 wells: From the Select Wells with dropdown menus, select Sample
and Unknown 2.

* Unknown 3 wells: From the Select Wells with dropdown menus, select Sample
and Unknown 3.

* Unknown 4 wells: From the Select Wells with dropdown menus, select Sample
and Unknown 4.

* Unknown 5 wells: From the Select Wells with dropdown menus, select Sample
and Unknown 5.

* Negative control-IPC wells: Select wells A5, A6, A7, and AS.
» Negative control-blocked IPC wells: Select wells A1, A2, A3, and A4.

5. Click and drag the Show Cycle pointer from cycle 1 to cycle 40, and review the data
from each filter:

+ The data from filter 1 correspond to the signal from FAM™ dye, the reporter for
the pathogen target. Increase indicates amplification of the target.

Notes
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ﬂ Chapter 5 Analyze the Experiment
View the Raw Data Plot

+ The data from filter 2 correspond to the signal from VIC®dye, the reporter for
the IPC target. Increase indicates amplification of the IPC.

+ The data from filter 3 correspond to the signal from ROX™ dye, which is used

as the passive reference.

6. Repeat steps 4 and 5 for each replicate group.
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The filters are:
StepOne system StepOnePlus system
Filter Dye Filter Dye
1 FAM™ dye 1 FAM™ dye
SYBR® Green dye SYBR® Green dye
2 JOE™ dye 2 JOE™ dye
| VIC® dye | VIC® dye
3 | ROX™ dye 3 | TAMRA™ dye
| " NED™ dye
4 ROX™ dye
Notes
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View the Raw Data Plot

Analysis When you analyze your own presence/absence experiment, look for the following in each
Guidelines filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, access the StepOne Software Help by
Information clicking @ or pressing F1.

Notes
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View the Raw Data Plot

Notes
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Appendix A

“ Alternate Experiment Workflows

This appendix covers:

B Advanced Setup Workflow . .. ... ... ... .. . . 110
B QuickStart Workflow . . ... ... . 111
B Template Workflow. . ... .. . 113
B Export/Import Workflow .. ....... .. .. .. .. .. . . . . 115

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems StepOne"™ Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » StepOne Software Help.

Notes
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Advanced Setup Workflow

Advanced Setup Workflow

When you create an experiment using Advanced Setup in the StepOne™ software, you
can set up the experiment according to your own design.

1. Double-click g- (StepOne software shortcut) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

2. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

3. Complete the setup screens to set up a new experiment:

a. Click Experiment Properties (default), enter the experiment name, then
select the experiment properties.

b. Click Plate Setup:
Experiment Type Action
Genotyping Define the SNP assays, then assign them to wells in the

reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Run Method, review the reaction volume and thermal profile, then
edit as needed.

d. Click Reaction Setup, review the components and calculated volumes for
the PCR reactions, then edit as needed.

e. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.

4. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve Prepare the template.

. Prepare the sample dilutions.
Prepare the standard dilution series.
Prepare the reaction mix.

Prepare the reaction plate.

Standard curve

® Qoo

Notes
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QuickStart Workflow

Experiment Type Action

Comparative Ct . Prepare the template.

a

Genotyping b. Prepare the samplle dl|l:ItI0nS.
c. Prepare the reaction mix.

Presence/absence d. Prepare the reaction plate.

5. Run the experiment:

a. Load the reaction plate into the instrument.

b. Start the run

c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
6. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve . Prepare the template.
. Prepare the sample dilutions.

a
b
c. Prepare the standard dilution series.
d
e

Standard curve

. Prepare the reaction mix.
. Prepare the reaction plate.

Comparative Cy a. Prepare the template.
Genotyping b. Prepare the samp.le dI|L'JtI0nS.
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.
Notes
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QuickStart Workflow

2. QuickStart the experiment:

a. Double-click g- (StepOne software shortcut) or select
Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.
b. From the Home screen, click |=Q| QuickStart.

c. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

d. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

4. In the StepOne software, complete the plate setup:

Experiment Type Action
Genotyping a. Select and complete the Define SNP Assays and
Samples tab.
b. Select and complete the Assign SNP Assays and
Samples tab.
All other experiments a. Select and complete the Define Targets and
Samples tab.

b. Select and complete the Assign Targets and
Samples tab.

5. Analyze the data:
Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Template Workflow

Template Workflow

A

You can use a template to create a new experiment. Templates are useful when you want
to create many experiments with the same setup information.

Createa 1. Double-click g (StepOne software shortcut) or select
Template Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 110).

3. Select File » Save As Template.
4. Enter a file name, select a location for the template, then click Save.

5. Click & Close.

Create an 1. From the Home screen, click Template.

Experiment with a
Template Note: If you do not see the Template icon, click the arrow beneath the Design

Wizard icon to expand the Set Up menu.

2. Locate and select the template you created in step d, then click Open. A new
experiment is created using the setup information from the template:

* Experiment properties
* Plate setup

* Run method

* Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see
page 110).

4. Click [d Save, enter a file name, then click Save to save the experiment.

5. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve Prepare the template.

. Prepare the sample dilutions.
Prepare the standard dilution series.
. Prepare the reaction mix.

Prepare the reaction plate.

Standard curve

® Qoo

Notes
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Appendix A Alternate Experiment Workflows
Template Workflow

Experiment Type Action
Comparative Ct a. Prepare the template.
Genotyping b. Prepare the samplle di|l:lti0nS.

c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

6. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

7. Analyze the data:
Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).
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Export/Import Workflow

Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Note: Setup data exported from experiments in StepOne Software v1.0 can be imported
into experiments in StepOne Software v2.0 or later. However, setup data exported from
experiments in StepOne Software v2.0 or later cannot be imported into experiments in
StepOne Software v1.0.

Export Setup 1. Double-click g (StepOne software shortcut) or select
Data Start » All Programs » Applied Biosystems » StepOne Software »
<software name>

where <software name> is the current version of the StepOne software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 110).
3. Select File » Export.

4. Select the Export Properties tab (default), then:
Select Setup.

a.
b. Select One File from the dropdown menu.

o

Enter a name, then select a location for the export file.

d. Select [Z] (*.txt) from the File Type dropdown menu.

IMPORTANT! You cannot export * .xml files.

5. (Optional) Click the Customize Export tab, then select the appropriate options.
6. Click Start Export,

7. When prompted, click Close Export Tool.

Create an  You can import plate setup data from an exported text file (*.txt) to complete the reaction
Experiment with  plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file you select contains only reaction plate setup
data and that the experiment types match.

Notes
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Export/Import Workflow

1. Import the reaction plate setup data from an exported text file:

a. Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

b. Replace the parameters of the text file as needed. When finished, save the file
as a tab-delimited text file.

c. From the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

d. Create a new experiment or open an existing experiment.

e. Select File » Import.

f. Click Browse, locate and select the text file (*.txt), then click Select.

g. Click Start Import. The setup data from the exported text file is imported into

the open experiment.

Note: If your experiment already contains plate setup information, the
software asks if you want to replace the plate setup with the data from the text
file. Click Yes to replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 110).

3. Prepare the PCR reactions:

Experiment Type Action

Relative standard curve | a. Prepare the template.

Standard curve b. Prepare the sample dI|L.ltIO-nS. .
c. Prepare the standard dilution series.

d. Prepare the reaction mix.

e

. Prepare the reaction plate.

Comparative C; . Prepare the template.

a
. b. Prepare the sample dilutions.
Genotyping P p ! u I
c. Prepare the reaction mix.
Presence/absence d. Prepare the reaction plate.

4. Run the experiment:
a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

Notes
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Export/Import Workflow

5. Analyze the data:

Open the experiment in the StepOne software.

a.
b. From the Experiment Menu, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Advanced Setup

AlF
allele

allelic discrimina-
tion plot

amplicon

amplification

amplification
efficiency (EFF%)

amplification plot

Glossary

In the StepOne™ software, a feature that allows you to set up your experiment according
to your experiment design. Advanced Setup provides you with maximum flexibility in the
design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed
in an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard
quantities and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed
as:

» Baseline-corrected normalized reporter (ARn) vs. cycle
* Normalized reporter (Rn) vs. cycle
» Threshold cycle (Cy) vs. well
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amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

baseline

122

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage
are displayed in an amplification plot, and the data are used to calculate results. For
genotyping or presence/absence experiments, fluorescence data collected during the
amplification stage are displayed in an amplification plot, and the data can be used for
troubleshooting. See also cycling stage.

In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers
to amplify a target and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify
a target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
» AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for
the amplification plot. You can apply the automatic baseline setting to specific wells in
the reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (Cy).

In the amplification plot, a line fit to the fluorescence levels during the initial stages of
PCR, when there is little change in fluorescence signal.
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baseline-corrected
normalized reporter
(ARnN)

blocked IPC

calibrator
chemistry

colocated layout

comparative C;
(AAC) method

Cr

custom dye

cycle threshold

Glossary

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence signal generated by the reporter at each cycle during the PCR
amplification. In the ARn vs. Cycle amplification plot, ARn is calculated at each
cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence signal generated by the reporter between the pre-PCR read
and the post-PCR read. In the allelic discrimination plot (genotyping experiments)
and the presence/absence plot (presence/absence experiments), ARn is calculated
as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

In presence/absence experiments, a reaction that contains IPC blocking agent, which
blocks amplification of the internal positive control (IPC). In the StepOne"” software, the
task for the IPC target in wells that contain IPC blocking agent. See also negative control-
blocked IPC wells.

See reference sample.
See reagents.

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly
connected to a colocated computer by the yellow cable. In this layout, you can control the
instrument with the StepOne™ software on the colocated computer or with the instrument
touchscreen.

Method for determining relative target quantity in samples. With the comparative C;
(AAC;) method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples and in a reference sample. Measurements are normalized
using the endogenous control. The software determines the relative quantity of target in
each sample by comparing normalized target quantity in each sample to normalized target
quantity in the reference sample.

See threshold cycle (Cy).
Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in

experiments on the StepOne™ and StepOnePlus'™ systems. When using custom dyes, the
custom dye should be added to the Dye Library and a custom dye calibration performed.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne” system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus"™ system.

See threshold cycle (Cy).
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cycling stage

data collection

delta Rn (ARN)

derivative reporter
(-Rn’)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor
dissociation curve
EFF%

endogenous
control

endpoint read

124

In the thermal profile, a stage that is repeated. A cycling stage is also called an
amplification stage. For cycling stages, you can enable AutoDelta settings. See also
amplification stage.

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the
signal to electronic data, and the data are saved in the experiment file. In the StepOne™
software, a data collection point is indicated by an icon in the thermal profile:

» Data collection on:

» Data collection off:
See baseline-corrected normalized reporter (ARn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn") vs. temperature melt curve,
the derivative reporter signal is displayed in the y-axis.

A feature in the StepOne ™ software that helps you set up your experiment by guiding you
through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of
the Reaction Setup screen. For this field, enter the sample concentration you want to use
to add to the reaction mix for all samples in the experiment. “10X for Reaction Mix”
indicates that the software assumes the sample or standard component of the reaction mix
is at a 10X concentration. For example, if the diluted sample concentration is 50.0 ng/uL
(10X), the final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.

See melt curve.

See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative C; (AACy)
experiments to normalize fluorescence signals for the target you are quantifying.

Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

See post-PCR read.
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experiment

experiment name

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent

Glossary

Refers to the entire process of performing a run using the StepOne™ or StepOnePlus"™
systems, including setup, run, and analysis. The types of experiments you can perform
using the StepOne and StepOnePlus systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative Cy (AACy)

* Melt curve

* Genotyping

* Presence/absence

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<),
asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), or
semicolon (;).

The type of experiment you are performing using the StepOne™™ or StepOnePlus™ system:

+ Standard curve
» Comparative C; (AACy)
» Relative standard curve
* Melt curve (not available in the Design Wizard)
* Genotyping
» Presence/absence
The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5” end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the
target is absent in the samples) and negative results caused by PCR inhibitors, incorrect
assay setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
StepOne™ software, the task for the IPC target in wells that contain the IPC and do not
contain [PC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).
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IPC+

made-to-order
assays

manual baseline

manual Cy

melt curve

melt curve stage
melting
temperature (Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control

(NTC)
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See negative control-IPC wells.

TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control
specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the
amplification plot. You can apply the manual baseline setting to specific wells in the
reaction plate.

An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate
the melting temperature (Tm) of the target or can identify nonspecific PCR amplification.
In the StepOne™" software, you can view the melt curve as normalized reporter (Rn) vs.
temperature or as derivative reporter (—Rn”) vs. temperature. Also called dissociation
curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the StepOne™ software, the task for targets or SNP assays in wells that contain water
or buffer instead of sample. No amplification of the target should occur in negative control
wells. Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked.
Previously called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).
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nonfluorescent
quencher-minor
groove binder
(NFQ-MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier

passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix
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Glossary

Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact,
the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence
signal. Because the NFQ does not fluoresce, it produces lower background signals,
resulting in improved precision in quantitation. The minor groove binder (MGB)
increases the melting temperature (Tm) without increasing probe length. It also allows the
design of shorter probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the
passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.

A dye that produces fluorescence signal. Because the passive reference signal should be
consistent across all wells, it is used to normalize the reporter dye signal to account for
non-PCR related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for high
data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In StepOne ™
systems, the grid contains 6 rows and 8 columns. In StepOnePlus"™ systems, the grid
contains 8 rows and 12 columns.

In the StepOne™ software, you can use the plate layout as a selection tool to assign well
contents, to view well assignments, and to view results. The plate layout can be printed,
included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard
curve is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain
a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also
called endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended.
Fluorescence data collected during the pre-PCR read can be used to normalize
fluorescence data collected during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.
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primer/probe mix

pure dye

quantitation
method

quantity

quencher

QuickStart

R2 value

ramp

ramp speed

raw data plot
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PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation
methods: standard curve, relative standard curve, and comparative C; (AAC).

In quantitation experiments, the amount of target in the samples. Absolute quantity can
refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-
difference between normalized quantity of target in the sample and normalized quantity
of target in the reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from
emitting fluorescence signal while the probe is intact. With TagMan® reagents, a
nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher.
With SYBR® Green reagents, no quencher is used.

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus"™ system.

A feature in StepOne’" and StepOnePlus'™ systems that allows you to run an experiment
without entering plate setup information. QuickStart requires a colocated layout with the
instrument powered on and an intact instrument-computer connection.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C data points from the standard reactions. A value of 1.00 indicates a perfect
fit between the regression line and the data points.

The rate at which the temperature changes during the instrument run. Except for the melt
curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is
defined as a temperature increment. In the graphical view of the thermal profile, the ramp
is indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

» For optimal results using the fast ramp speed, Applied Biosystems recommends
using TagMan® Fast reagents in your PCR reactions.

» For optimal results using the standard ramp speed, Applied Biosystems
recommends using standard reagents in your PCR reactions.

IMPORTANT! TagMan Fast reagents are not supported for genotyping or
presence/absence experiments.

A plot of raw fluorescence signal (not normalized) for each optical filter.
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reaction mix

reagents

real-time PCR

reference sample

refSNP ID

regression
coefficients

regression line

reject well

relative standard
curve method

Remote Monitor

Glossary

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or control).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the StepOne"™ and StepOnePlus™ systems:

+ TagMan® reagents
+ SYBR® Green reagents
* Other reagents

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping
or presence/absence experiments.

In relative standard curve and comparative C (AAC;) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National
Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the
Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called
an rs number.

Values calculated from the regression line in standard curves, including the R? value,
slope, and y-intercept. You can use the regression coefficients to evaluate the quality of
results from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m [log (Qty)] + b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard
curve method, the StepOne™ software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution series.
Measurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A feature in the StepOne'" software that allows you to monitor a StepOne™ or
StepOnePlus'™ instrument over the network. With the Remote Monitor, you can monitor
the instrument status, send an experiment to the instrument, monitor amplification plots
and temperature plots in real time, and download the results to your computer. You cannot
operate the StepOne or StepOnePlus instrument using the Remote Monitor.
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replicate group

replicates

reporter

reverse primer
reverse
transcriptase
Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction
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A set of identical reactions in an experiment.

Total number of identical reactions containing identical components and identical
volumes.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter
dye is SYBR® Green dye.

An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR
reaction to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the StepOne"™ and
StepOnePlus™ systems. ROX dye is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the StepOne™ or
StepOnePlus'™ instrument run.

The template that you are testing.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is
added to the reaction mix at a 10X concentration. For example, if the reaction volume is
20 pL, the calculated volume of sample for 1 reaction is 2 uL.

In the StepOne™ software, a collection of samples. The Sample Library contains the
sample name and the sample color.

In the StepOne™ software, a reaction component displayed on the Reaction Mix
Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volume is 20 pL, the calculated volume of sample or standard for 1 reaction is 2 uL.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and
quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify
more than one target in one PCR reaction.
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serial factor

series

slope

SNP

SNP assay

SNP Assay Library

spatial calibration

stage

standalone layout

standard

standard curve

Glossary

In the StepOne™ software, a numerical value that defines the sequence of quantities in the
standard curve. The serial factor and the starting quantity are used to calculate the
standard quantity for each point in the standard curve. For example, if the standard curve
is defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points
in the curve is 10-fold.

See standard dilution series.

Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

Abbreviation for single nucleotide polymorphism. The SNP can consist of a base
difference or an insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the StepOne ™ software, a collection of SNP assays to add to genotyping experiments.
The SNP assays in the library contain the SNP assay name, SNP assay color, and for each
allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in
the library may also contain the assay ID and comments about the SNP assay.

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the
positions of the wells in the sample block(s). Spatial calibration data are used so that the
software can associate increases in fluorescence during a run with specific wells in the
reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages:
holding stage (including pre-PCR read and post-PCR read), cycling stage (also called
amplification stage), and melt curve stage.

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to
a computer by the yellow cable. In this layout, you control the instrument only with the
instrument touchscreen, and you use a USB drive or network connection to transfer data
between the instrument and computer.

Sample that contains known standard quantities. Standard reactions are used in
quantitation experiments to generate standard curves. See also standard curve and
standard dilution series.

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C; values from the standard reactions plotted
against standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is
defined by the number of points in the dilution series, the number of standard
replicates, the starting quantity, and the serial factor. See also standard dilution
series.
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Method for determining absolute target quantity in samples. With the standard curve
method, the StepOne™™ software measures amplification of the target in samples and in a
standard dilution series. Data from the standard dilution series are used to generate the
standard curve. Using the standard curve, the software interpolates the absolute quantity
of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the
first dilution point is used to prepare the second dilution point, and so on. In the StepOne™
software, the volumes needed to prepare a standard dilution series are calculated by the
number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the
StepOne"™ software, the units for standard quantity can be for mass, copy number,
viral load, or other units for measuring the quantity of target.

* In relative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the StepOne"" software, corresponds to the highest or
lowest quantity.

A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™
systems, which contain the VeriFlex'" blocks, each step contains 6 temperatures (1 for
each VeriFlex block).

PCR reaction components that consist of two primers designed to amplify the target and
SYBR® Green dye to detect double-stranded DNA.
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system dye

TaqgMan® reagents

target

target color

Target Library

task

Glossary

Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or
StepOnePlus"™ system. Before you use system dyes in your experiments, make sure the
system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne system:
« FAM™ dye
+ JOE™ dye
+ ROX™ dye
+ SYBR® Green dye
+ VIC® dye
System dyes on the StepOnePlus system:
+ FAM"™ dye
« JOE™ dye
+ NED™ dye
+ ROX™ dye
+ SYBR® Green dye
+ TAMRA™ dye
+ VIC® dye

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as
reporter or quencher with the StepOne”™ system. TAMRA dye may be used as a reporter
or quencher with the StepOnePlus™ system.

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the StepOne ™ software, a color assigned to a target to identify the target in the plate
layout and analysis plots.

In the StepOne™ software, a collection of targets to add to experiments. The targets in the
library contain the target name, reporter, quencher, and target color. The target in the
library may also contain comments about the target.

In the StepOne™ software, the type of reaction performed in the well for the target or SNP
assay. Available tasks:

* Unknown

* Negative Control

 Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ IPC (presence/absence experiments)

» Blocked IPC (presence/absence experiments)
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temperature plot

template

thermal profile

threshold
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Tm
touchscreen

unknown

unknown-IPC wells
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In the StepOne "™ software, a display of temperatures for the sample, instrument cover, and
instrument block during the StepOne"™ or StepOnePlus"™ instrument run.

In the Design Wizard of the StepOne"™ software (and in QuickStart for quantitation
experiments), the type of nucleic acid to add to the PCR reaction. The recommended
template varies according to experiment type:

* Quantitation experiments (standard curve, relative standard curve, and comparative
C1) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

* Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
* Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection
points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic Cy) or can be set manually (see manual Cy).

2. In presence/absence experiments, the level of fluorescence above which the
StepOne™ software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification
plot.

See melting temperature (Tm).
Instrument display that you touch to control the StepOne"™ or StepOnePlus™ instrument.

In the StepOne™ software, the task for the target or SNP assay in wells that contain the
sample you are testing:

* In quantitation experiments, the task for the target in wells that contain a sample
with unknown target quantities.

* In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

 In presence/absence experiments, the task for the target in wells that contain a
sample in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control
(IPC).
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VeriFlex™
Technology

y-intercept

Zone

zone boundary

Glossary

The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex
blocks, creating up to six different zones for the 96 sample wells. After you enable the
VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or
more of the VeriFlex blocks.

In the standard curve, the value of y where the regression line crosses the y-axis. The y-
intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.

One of up to six sample temperatures among the 96 wells formed by independently
thermally regulated VeriFlex'" blocks during the StepOnePlus™ instrument run. You can
set a different temperature for one or more of the VeriFlex blocks, or you can set the same
temperature for each of the VeriFlex blocks.

Note: For melt curve steps, you need to set the same temperature for each of the
VeriFlex blocks.

The edge of a zone for samples formed by the six independently thermally regulated
VeriFlex"™ blocks. In the StepOne"™ software, the zone boundaries are displayed in the
plate layout as thick red lines.
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instrument operation, safety xvii
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Methods and Materials screen 23
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